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Introducing Scheduler

Overview

Using this Guide

Scheduler builds and maintains school and student timetables. Scheduler
constructs classes as sections of courses, by building on the course, student,
teacher, and room information established in School Setup and Details. The
classes are populated with students and 1 or more teachers, and scheduled
in rooms at times established in School Setup by year, monthly calendar,
day, period, and block structure. Use Scheduler to manually or
automatically build these timetables, but follow the procedures in the order
given.

Scheduler accommodates up to:

6000 students 12 terms*

750 teachers 14 days per cycle
750 rooms 304 blocks per cycle*
1000 courses 42 periods per day
2000 classes 32,767 time records

* Number of blocks multiplied by number of terms must not exceed 1400.

We strongly recommend that you use this guide in conjunction with the
Win School System Administrator Guide, which contains scheduling tips,
and the Win School Getting Started Guide, which contains concepts and a
glossary.

This guide gives Scheduler information and procedures in these sections:

Using Scheduler Features: how to start Scheduler, how to view specific
information, and how to use some of the major Scheduler features.

Preparing to Schedule a New Year: all of the setup work you do in other
Win School modules in order to run Scheduler.

Scheduling Your School: all of the major tasks you do in Scheduler in the
order you should do them to schedule a school year.

Scheduling Fragmented Course Requests: how to schedule term-based
course requests for students taking a term of a course in a different year.

Using Windows and Functions: many of the windows and commands in
Scheduler are described in detail, including when and how to use them.

Printing Reports: most of the Scheduler reports are described, including
how to find them, what they include, and how to generate them.

Introducing Scheduler e Overview 1
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Troubleshooting: tips and techniques to use if you have difficulties.

Glossary: explanations of terms used in Scheduler.

Terminology

Some terminology is used in special ways in both Win School and this
guide. See the Glossary for special terms.

Getting Technical Support

Chancery’s support programs are available by subscription and include the
below services.

Technical Support solves problems and answers questions when
software doesn’t produce the expected results.

Monday to Friday, 5 am to 5 pm Pacific Time
phone: 1-800-688-9939

fax: 1-800-346-0643

email: techsupp@chancery.com

website: http://support.chancery.com

Web support Chancery’s website includes a searchable
knowledge base with frequently asked questions,
tips, and troubleshooting, as well as support
forums for users to share experience and
knowledge. Web tutorials are available on an
annual subscription basis.

Software updates releases of new versions with improved functions
and software fixes. Updates are provided free of
charge for 3 months from your date of purchase
and are included in the subscription to Chancery
Support Programs.

For more information on Technical Support Programs, call Chancery
Customer Service at 1-800-999-9931 extension 130.

Providing Feedback

To improve the quality of your documentation, we would like your
comments regarding this guide. Email comments to Chancery’s User
Education department at user_docs @chancery.com.
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Using Scheduler Features

Overview

Starting Scheduler

To start using Scheduler, you need to know some fundamentals: how to
start Scheduler, and where features are located.

You also need to decide whether you will use students’ Fragmented Course
Requests. If you use Fragmented (term-based) Course Requests, read
“Scheduling Fragmented Course Requests” on page 71 in addition to the
other sections before scheduling your school.

Class rosters created in Scheduler can be used by other Win School
modules. They can display class rosters and when and where classes meet.

e Query displays where students and teachers are scheduled at any time
of any day

e Period attendance can be recorded by class
e Attendance can be scanned by an optical scanner
e C(Class attendance can be loaded into Report Cards

e ¢Class Grades uses the rosters built in Scheduler

When you start Scheduler, you choose the mode to start it:

Master: While you are using Scheduler, no one else can run it. No other
modules can run while you are using Scheduler. All features are available.

Choose Master mode to build master timetables.

Multi-User: Many users can run Scheduler at the same time. Details,
Attendance, and Report Cards can also run. Other modules are not
available. You can view, but not edit, the School Timetable.

Choose Multi-User mode to edit student timetables, and let other modules
run.

P ualti-Lizer Master

|Jze this mode when you wish to build master imetables. Maote
yau will nat be able ta run other modules.

oK | Cancel |
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To check which start method you used:

e  (Click the Scheduler Information Icon in the title bar of the Scheduler
Main window.

Archiving the Data Folder / Saving Scheduling Runs

Before making changes, make a copy of your data folder. Either back up
the data folder using your normal backup procedure or duplicate it in
Windows®. The copy is an archive. Then make changes. If the result is a
better timetable, you can delete the archived data. But if you don’t like the
result, you can always replace it with the archived data.

Using Scheduler Features
The Main window is always open when you are running Scheduler. Press
F5 to bring it to the front.

Click the Information icon to see what is going on in your current session.
A student information section is added to the bottom of the information
dialog if you open it from a Student Timetable or Student Requests
window.

Use the windows in Scheduler as you would in any other module.

Using Main Window Views

The 7 main views in Scheduler include 2 types of student grouping: all
students, or subsets of students.

View Left-Double-Click an Item Right-Double-Click an Item
Students Opens the student timetable | Opens the student requests
window window
Teachers Opens the teacher timetable | Generates a subset of students
window who have the highlighted
teacher as a counselor
Rooms Opens the room timetable Generates a subset of students
window who have that room as a
homeroom
Courses Opens the sections window, | Generates a subset of students
with the highlighted course | who have requests for the
displayed highlighted course

4 Using Scheduler Features e Archiving the Data Folder / Saving Scheduling Runs
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View Left-Double-Click an ltem Right-Double-Click an Item
Classes Opens the school timetable | Generates a student subset of
window, with the the class roster for the
highlighted class displayed | highlighted class
Lists Not applicable Generates a student subset
based on ethnic category,
gender, grade, home language,
normal program, school,
special program, student group
or track
&8 cSL Scheduler Scheduler-&m [=0] _ (O] X
File Edit “Windows Schedule Beports Lists Help
.o d
t | O M. %
Chudent: || Teachers Rooms Courzes Clazzes Ligtz
| &l Students | Student Subset I |Viewing all students
Normal Selected
Humber Student Name Program Req Sch Agd Grade [102]
|

[ T |

| ET | [T T

1025 aff, Martin Fred... || Academic R.00| 0.00 i E
1002 Allzop, Boxie dlexe o' Academic 00 0.00 2 m 4]
100300 | Allzop, Suzan Francine | % | Academic 200 0.00 o1z <]
100400 | Anstep, Jennifer Marga... | 2 | Academic 300 0.00 FA 4
1005 Azimov, |saac Bernard 0" Adwanced.. | 400 0.00 g0 12 2
1008 Barizsaff, Larizza Marie 2 Academic RO0 | 0.00 721 <]
9712344 | Bean, Jamal Melvin a'| M 450 0.00 0o M =] Ll

Other Notes

Classes are scheduled, not courses.

Courses are created in Course Details. When students request the courses
they want to take, they are assigned to sections of courses, called either

sections or classes. A course can have none, 1, or many classes, identified
as a class by course name and section number.

In Scheduler, section and class mean the same thing, except for class rank
which means the rank of a student within the grade level.

Using Students View

You can use VCR buttons in the third and fourth columns in the Students
Main window to display Req Sch Rqd:

Req: Scheduling Credit total for the courses the student has requested (not
including Alternate requests).

Sch: Scheduling Credit total for the classes in which the student is
scheduled.

Using Scheduler Features e Using Scheduler Features 5
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Rqd: number of credits required for the Normal program at the student
grade level.

If students are missing from the Student window, they might be inactive or
assigned to Grade N/A. Preferences determine the student list. For more
information, see ‘“Preferences — Scheduler” on page 88.

If you are using Fragmented (term-based) Course Requests, these columns
show the requested terms. For more information, see “Scheduling
Fragmented Course Requests” on page 71.

The information bar in the window heading describes the set of students
being viewed. The total for a class roster subset always includes inactive
students and those assigned to grade N/A. Preferences determine the
student list.

Commands that require selected students process whichever student list you
viewed most recently in the Main window.

Student Requests and Student Timetable windows allow you to switch to
the previous or next student in whichever student list you viewed most
recently in the Main window.

In the Student Timetable window, use the F3 and F4 keys to move forward
and back through student records for either main or subset lists.

To create a Student Subset, either right-double-click an item in another
view, or select a command from the Lists menu.

When you generate a Student Subset, Win School replaces the existing
Student Subset with the new one.

To generate this Student Subset from the Choose this option Or, right-double-

Students view: from the Lists Menu in click an item in this
the Students view: view:

Students selected in the current window Selected Students

Students with a teacher as counselor Counselor’s Students Teachers view

Students in a homeroom Homeroom Roster Rooms view

Students who have first-choice (not alternate) Request List Courses view

requests for a course

Students who have first-choice (not alternate) Wait List

requests for a course, who are not scheduled

Students scheduled for a class Class Roster Classes view

Students in a grade Grade Roster Lists view Grades

category
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To generate this Student Subset from the
Students view:

Choose this option
from the Lists Menu in
the Students view:

Or, right-double-
click an item in this
view:

Students who fail to meet prerequisite, co-
requisite, or gender requirements of requested
courses

Request Problems

Students who entered or left a class on the
currently selected transfer date

Changed

Students who fail to meet prerequisite, co-
requisite, or gender requirements of their
scheduled courses

Timetable Problems

Students who have not requested enough credits | Requested < Required
for program requirements

Students not scheduled for as many credits as Scheduled < Requested
they requested

Students not scheduled for as many credits as Scheduled < Required

their program requires

Students classified by ethnic category, gender,
home language, normal program, school,
special program, student group or track

Lists view. Select a
category

Using Lists View

You can use the Lists view to create a Student Subset for a category of

students you choose.

To generate a Student Subset:

1 In Lists view, choose a category of students from the popup menu.

Category values are defined in the School Setup module from the
Student/General selection in the School menu. The categories are:

Ethnic
Grades
Normal program
Special program

Track

Gender

Home languages

School name

Student groups

2 Right-double-click a category value. The student records with that
value are displayed in a Student Subset view.

Using Scheduler Features e Using Scheduler Features
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Preparing to Schedule a New Year

Overview

Perform the scheduling procedures in the order described.

Complete all procedures in the given order. Do not go on to the next procedure
until you have completed the previous one. Each step depends on the previous
step.

As you schedule, expect to go back to earlier steps to change information. But
when you do, work through all the steps again, don’t jump to where you left off.

If you want to use Fragmented course requests, read “Scheduling
Fragmented Course Requests” on page 71 in addition to the other sections
before scheduling your school.

Preparing to Schedule the Next Year

To prepare current-year data for next year:

1 Create a Next Year data folder, as described in “Setting Up the Next
School Year” in the Win School System Administrator Guide.

2 Set up data options for next year in School Setup and Details in the
next year database. See the Win School School Setup and Details
guides.

3 Run the Year End process, described in the Win School System
Administrator Guide.

Scheduling a New Year

To schedule a new school year:
1 Enter student course requests.

2 Create classes. Either manually or automatically create enough classes
each term to satisfy course requests.

3 Load teachers. To automatically schedule, check that you have enough
teachers loaded for your classes.

Create school timetable. Schedule classes, teachers, and rooms.
Create student timetables. Schedule students into their classes.

Start the school year.

N O »n b~

Maintain schedules during the school year.

8 Preparing to Schedule a New Year e Overview
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Next Year Data Prep

Year End

Scheduling

Students Courses

Oy

Requests

Student request lists
Course wait lists

Teachers Rooms

©

School Timetable
Teachers, Rooms, Classes

oy

Student

Timetables

Using Other Procedures

Some schools also use other Scheduler features.

To Use

schedule parts of a course in different terms or Fragmented Course
different years Requests

schedule more than 1 class in 1 room Class Combining
schedule second teachers, and teaching aides Assign Aides
schedule groups of students and groups of teachers Clusters and Teams

Preparing to Schedule a New Year ¢ Overview 9
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To Use

schedule classes or students from other schools Working with Other
Schools

scramble periods so that classes are not taught in the Scramble Periods

same period each day

Changing from Report Cards to Scheduler

If you created classes in Report Cards using Edit Classes, you cannot run
Scheduler using the same data. Create a new data folder using Next Year
Prep from the Shell, then start scheduling from scratch.

Refer to the Win School System Administrator Guide for more information
on Next Year Prep.

Preparing Data for the Next Year

Before starting to schedule the next year, complete a series of tasks to
prepare data for the next school year. Each school year requires a separate
data folder. This data folder can be on the same server or a different server.

If you are running Win School multi-user on an NT server using TCP/IP,
you can set up multiple servers, one for current year data, and one for next
year’s data. For more information, see the System Administrator Guide.

Use the following procedures in order: to prepare data for the next year and
create a next year data folder. Then run Next Year Prep.

See also “Setting Up the Next School Year” in the Win School System
Administrator Guide.

If you used Report Cards and not Scheduler to create classes, you will not
be able to use data from the Historical file with Scheduler in preparing data
for the next year. The 2 data sets are not compatible.

To prepare data for the next year and create a data folder for next year:

1 Update and check information in Details and Report Cards to make
data as current as possible for preparation of data for the next school
year.

2 If you schedule by class rank in the Report Cards module, run Class
Rank from the Edit menu. See “Generating Class Rank and Honor
Roll” in the Win School System Administrator Guide.

3 Write down the data path for the current year’s data. This information
is displayed in the Win School Shell. Usually, the data path is
something like C:\WINSCHL\DATA.

4 Quit the Shell and back up your current year’s data.

5 If you are using the multi-user version of Win School, log onto the Win
School server as the administrator.
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If you are using multiple NT servers, install next year’s server. See
“Setting Up Multiple Win School NT Servers” in the Win School
System Administrator Guide.

If you are using the single-user version of Win School, create a
directory for next year’s database that you can access using the
computer running Win School. This new directory should follow the
same path you wrote down in step 2 except for a different name for the
last part of the path. The last part of the path is the name of the current
year’s data directory; therefore, you must type a name for your next
year’s data directory, a name which references the school year. For
example, use “DATA9899” to name the 1998-1999 school year’s data
directory.

Write down the information of next year’s directory as you need it
when you run Next Year Prep and to access next year’s data. If you are
using multiple servers, write down the server information including the
server IP address and port number.

To run Next Year Prep:

1
2
3

Start the Win School Shell.
From the Shell menu, choose Next Year Prep.

In the Select Next Year’s Directory dialog, double-click next year’s
data folder so that it is open. Click OK.

Win School creates next year’s database and displays the Next Year
Prep dialog. Specify the location of the Win School icon to access next
year’s database. Click OK.

Next Year Prep m

Mext “rear Prep will add a new icon to the
Pragram Folder listed below. You can type a
new falder name, or select an existing folder
from the list.

Exizting Folders:
|

ACCessones -
Adobe _
Chancery Products

Main

M5 Office 4.2 L
M5 Office 57

Morton Antivirug — |
Other Proarams

0K I Cancel |

The folder with next year’s database icon is opened, and a message
informs you that Next Year Prep is complete.

Click OK.
Quit the Win School Shell.
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After running Next Year Prep, we recommend you do not delete students
from the current year’s data. Similarly, add new courses, students, or
teachers pertaining to next year in the next year database. If you need to add
any students, teachers, or courses to the current year’s database, you also
have to add that information to the next year’s database.

Preparing Year End

When the current school year ends, run “Current Year End” and
“Current/Next Year Merge” in the Utilities module. This updates the Next
Year Data with changes to student information made to the current-year
data since running Next Year Prep.

Use only the Next Year Data folder for the following procedures. Use the
checklist at the start of each procedure for each module, in the order given,
to change data for the coming school year.

Preparing School Setup

In the Next Year Data folder, complete the following data fields for the year
to be scheduled. The School Year and Set Scheduler Terms set the year.

School menu Scheduler menu

School Year Set Scheduler Terms

Define Grade Levels Timetable Structure

Transfer Recording OFF Teacher Course Load
Reservation Labels

Rooms menu Period Labels

Room Types Block Labels

Room Setup Scheduling Drop Date

Room Clone Scheduling Aide Types

Students - General menu
Normal Programs
Special Programs

For Timetable Structure in the Scheduler menu: if you change the number
of terms in the Set Scheduler Terms dialog or decrease the number of
blocks in the Timetable Structure dialog, the only scheduling data you can
access is student course requests. You will have to create new school and
student timetables.
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Preparing Course Details

In the Next Year Data folder, Details module, Courses view, check each of
the following data fields and make changes if necessary.

General tab
Course No.
Course Name
Grade Level
Department
Keep History

Periods tab

Usable blocks/periods for this course
No. of unique block letters

Spread over how many days

Periods per day

Same periods each day

Consecutive periods

All sections in the same blocks

Lists tab
Prerequisites
Co-requisites
Rooms

Required Programs
Requested Programs

Scheduler tab

Course length (in terms)
Terms are consecutive
Course can start in term(s)
Course can be taught in term(s)
Teacher Required
Maximum class size
Minimum class size
Student mix

EFT

Preceding Course

Allow Combining *
Room Required
Scheduling Credits
Student Clusters

Use in Scheduler

Aide Type

District Use Only

* To allow 1 teacher to teach more
than 1 class in 1 period, use Allow
Combining.

To make Create Timetable schedule courses into the same period, or in
consecutive periods, choose Following Triplets/Linked Groups from the
Details menu. For more information, see “Choose Sections According to
Linked Groups and Following Triplets” on page 78.

Preparing to Schedule a New Year e Preparing Data for the Next Year
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Preparing Teacher Details

In the Next Year Data folder, Details module, Teachers view, complete the
following data fields.

Personal tab Scheduler tab

Teacher number Course preferences

Name Room preferences

Department Scheduling teacher type

Homeroom Number Aide Type

Counselor Maximum number of blocks teacher

can be scheduled for

Clone those teachers who will be teaching more than 1 class at once in
different rooms, and in Course Details, use Allow Class Combining in the
Scheduler tab to schedule teachers to teach more than 1 class at once in the
same room. For more information on class combining, see “Scheduling
Simultaneous Classes in the Same Room (Class Combining)” on page 29.

If you want to assign teaching teams or assign teachers to clustered classes,
set up Clusters & Teams in the Schedule menu, then in the Details module,
use Team Teaching from the Details menu to assign teaching teams.

Preparing Student Details

In the Next Year Data folder, Details module, Students view, complete the

following data fields.
Personal tab Groups tab
Student No. Normal program
Name Special program
Gender Counselor
Grade Level

Homeroom Number
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Scheduling Your School

Overview

The process of scheduling a school for the new school year consists of 7
steps.

To schedule a new school year:
1 Enter student course requests.

2 Create classes. Either manually or automatically create enough classes
each term to satisfy course requests.

3 Load teachers. To automatically schedule, check that you have enough
teachers loaded for your classes.

4 Create school timetable. Schedule classes, teachers, and rooms.
5 Create student timetables. Schedule students into their classes.
6  Start the school year.

7 Maintain schedules during the school year.

Scheduler works through the scheduling process in order of most-difficult-
to-schedule, to least-difficult.

General order of scheduling:
1 Special Courses such as:
e Courses with 1 section.
e Courses using team teaching.
e Clusters where groups of students move together to classes.

e Class Combining such as Spanish 11 and 12 in the same room with
the same teacher.

e Linked Groups and Following Triplets where students stay together
but the teacher and room may change. For example: Biology and
Biology Lab, or Math 11a, 11b, 11c where algebra, geometry, and
trigonometry may be taught by different teachers.

2 Courses with more than 1 section.

Use the lists and reports from the Reports and Lists menus in Scheduler to
check progress of scheduling as suggested at appropriate points in these
procedures. For more information on the purposes and contents of reports,
see “Printing Reports” on page 96.
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Step 1: Entering Student Requests

Win School treats all scheduling as ‘by-request’ for both required and
elective courses. Usually, to save time, schools schedule required courses
automatically for all students. Win School treats required courses as being
required by students in a specific grade level and normal program. You set
grade level and program in the Details module.

Electives and required courses that are requested by students but not
required for program completion, can be either automatically or manually
scheduled, or a mix.

If you schedule your school automatically, the first step is to enter student
course requests. Use the procedures and steps in the order described in each
sub-section. Skip procedures that don’t apply to your situation.

Assigning Required Courses

Choose Assign Requests from the Schedule menu to assign each student a
request for the required courses in her or his grade level and program. You
set up required courses in Details, as Requested and Required for a specific
program.

Win School looks for courses in the right program, at the required grade
level, and other requirements such as gender, then gives the student a
request for each required course.

If you assign requests more than once, students will have duplicate
requests. If you want to assign Fragmented, or term-based, course requests,
you must remove duplicate requests first. To remove duplicate requests, see
“Removing Duplicate Requests” on page 20.

To assign requests:

1 In the Main window, select students.

2 From the Schedule menu, choose Assign Requests.

3 A dialog asks you to confirm that you want to assign requests.

Entering Non-Required Requests

After you assign requests for required courses, enter requests for non-
required courses, also called electives.

Four methods to assign requests for courses:

e Scanning: For information on Scanning, see the Scanning and ASCII
Transfer Guide.

e ASCII Transfer: If you store requests in another program, use ASCII
Transfer to enter them into Win School. For information on ASCII
Transfer, see the Scanning and ASCII Transfer Guide.
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e Editing Requests: Manually edit requests in Scheduler. See “Adding
Requests” on page 17 and “Deleting Requests” on page 18.

e Pasting Requests: In Scheduler, copy requests to 1 or more students.
See “Pasting Requests” on page 19.

Using the Student Requests Window

To display the Student Requests window:

e From the Windows menu, choose Student Requests.
OR
In the Students view, right-double-click a student.

The top half of the Student Requests window lists all courses in the same
order as in the Main Scheduler window.

The Status column reports course requirements in relation to the student
currently displayed in the Student Requests window. The column may
contain the following information:

“Required” or “Elective” is displayed at the left. A course is required if:

e the program for the student is in the Required Programs list of the
Course Details Lists dialog—Required Programs

e the course and student are in the same grade

e the student meets any gender requirements

Otherwise, the course is elective for the student.

Gender appears if the student is the wrong gender for the course.

CoReq: Course Name indicates that the student has not requested the
specific course, which is co-requisite for the course in the Course Name

column. If co-requisites are not required for the course, or if the student has

requested them all, CoReq... does not display.

PreReq: Course Name indicates that the student has not requested the
specified course, which is prerequisite to the course in the Course Name
column. If prerequisites are not required, or if the student has requested
them all, PreReq... does not display.

If a student has both gender and prerequisite/co-requisite problems with a
particular course, gender takes priority and is displayed in the Status
column. Reported gender, prerequisite, or co-requisite problems are only

alerts that a problem might exist. You can still assign the request as usual.

Adding Requests

Add requests in the Student Requests window. The order of entering
requests is important.

Scheduling Your School e Step 1: Entering Student Requests
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To add a course request:

1 In the Students view, right-double-click a student to open the Student
Requests window.

Use F3 and F4 to move back and forth between students.

Courses are added above the highlighted line in the Requests list.
2 In the upper list:

e to request a first-choice, left-double-click a course

e torequest a linked alternate, highlight a course in the Requests list,
then right-double-click a course in the upper list

e to add a global alternate, put the cursor anywhere in the Global
Alternates list and left-double-click a course in the upper list

For information on linked alternates and global alternates, see “Use
Alternates” on page 80 and “Use Backtracking” on page 80.

B Student Requests Scheduler-=g [=0] _ [T x

|F|equests for: 171 - Abrosimoff, Martin Frederici Feq: 5.00 Sch 4.00 Fgd: 7.2

Course Number Course Hame Statusz Regquests
[ 1 T T [
-
55 Adv. Spanizh Elective 0
M Algebra 11 Required 27
222 Algebra 12 Elective 38
333 Biology 11 Fequired CoReq: Biology Lab 11 0
444 Biolagy 12 Elective FreReqBiology 11 0
555 Biclogy Lab 11 Required CoReq: Biology 11 0
BEE Bookkeeping 11 Elective 20
119 Caloulus 12 Elective et
TEE Cheriztry 11 Required E
aaa Chemiztry 12 Elective PreReq:Chemisty 11 0
10 Conputer Scishce 11 Required 29
11 Dirafting 12 Elective PreReq.algebra 12 15 ¥
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Computer Science 11 0500
English 11 1.000
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Phyzical Education 11 1.000
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Deleting Requests

There are 3 ways you can delete requests. You can select students and
delete all their course requests, you can select students and courses and
delete the selected courses from the selected students, and finally, you can
delete 1 request for 1 student.

To delete a single request:

e Highlight the course in the Requests list and press Delete.
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To delete all requests from selected students:

1
2

3

Select students in the Main window.

From the Schedule menu, choose Change Students, then select the
Clear Requests checkbox to clear first choice requests.

To clear alternate requests, select the Clear Alternates checkbox.

Click Perform.

To delete selected course requests from selected students:

1
2
3

Select courses in the Courses view.
From the Schedule menu, choose Clear.

In the Clear dialog, select the “Clear selected courses from student
request lists” radio button.

To make the linked requests of alternate requests into primary requests,
select the “Replace first-choice request with its linked alternate”
checkbox.

Click Clear to begin removing requests.

Pasting Requests

Add requests to 1 or more request lists by pasting. You can copy 1 or more
request lists to 1 or more students. Pasting a list replaces an existing list.
Use this procedure when you have students taking the same courses.

To paste courses or a request list to 1 student:

1

3

In the Courses view, highlight the course.
OR

For a Request List, in the Students or Student Subset view, highlight
the source student.

From the Edit menu, choose Copy.
OR

For a Request List, choose Copy from the Edit menu, then select
Requests. Click OK.

To display clipboard contents, click the Information icon in the title bar
or press F2.

Highlight the destination name in Students view.

4  From the Edit menu, choose Paste.
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To paste requests to several students (multi-pasting):

1

Adding Co-Requisites

In the Courses view, highlight the course.
OR

For a Request List, in the Students or Student Subset view, highlight
the source student.

From the Edit menu, choose Copy.
OR

For a Request List, choose Copy from the Edit menu, then select
Requests. Click OK.

To display clipboard contents, click the Information icon in the title bar
or press F2.

Select the destination students’ checkboxes in the Main window.
From the Edit menu, choose Multi-Paste.

Click OK.

Co-requisites are defined in Course Details.

To add co-requisite requests:

1

2
3
4

Select students in the Main window.

From the Schedule menu, choose Change Students.
Select the Add Co-requisites checkbox.

Click Perform.

Removing Duplicate Requests

To ensure students have not requested a course more than once, delete
duplicate requests.

If you want to assign Fragmented course requests, you must remove
duplicate requests before assigning students and assigning Fragmented
course requests.

To delete duplicate requests:

1

2
3
4

Select students in the Main window.
From the Schedule menu, choose Change Students.
Select the Remove Duplicate Requests checkbox.

Click Perform.
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Monitoring the Course Request Process

To track progress when entering course requests, you can use different
views in the Scheduler window, use VCR buttons to view different
information, and work on only the students in the subset.

Viewing Required and Requested Totals
In the Students Main window, use the VCR buttons in the third or fourth
column to display “Req Sch Rqd.”

e Reqis the total of the Scheduler Credits for the student’s first-choice
requests.

e Sch shows the number of requests currently scheduled.

e Rqd is the number of credits required for the Normal program and
grade level of that student.

These columns reflect the requested terms. If you are using Fragmented
(term-based) Course Requests, and a student requested 2 terms of a 2 term
course, but can only be scheduled into 1 term, the Sch column shows half
the credit for that request.

B CsSL Scheduler Scheduereg [<=of _ [Of
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To generate a student subset for insufficient requests to meet program
credit requirements:

1 From the Lists menu, choose Requested < Required.

2 The view shows the Student Subset with the number of students that
meet the criterion.

To select individual students, use the checkboxes, or, to select all
students, shift-click an unselected checkbox.

To print the selected students, choose Print from the System menu.
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You can use the same procedure to generate subsets of students with
unscheduled requests, and students whose scheduled requests are less than
required.

To generate a student subset for missing prerequisites, co-requisites, or
gender requirements:

1 From the Lists menu, choose Request Problems.

2 In the Request Problems dialog, select the checkbox for problems with
Prerequisites, Co-requisites, and/or Gender Restrictions. Click OK.

3 The view shows the Student Subset with the number of students that
meet the criteria.

To select individual students, use the checkboxes, or, to select all
students, shift-click an unselected checkbox.

To print the selected students, choose Print from the System menu.

Viewing Requests by Course

In the Courses Main window, use the VCR buttons in the third or fourth
column to display the information most useful for your stage of scheduling.

Display Requests in third or fourth column, for the number of first-choice
requests for that course.

BcsiSooer  EESEEED

File Edit “Windows Schedule Repors Lists Help

t | & H & %

Students Teacherz Rooms Courses Clazzes Lizts

M aximum Class Selected
Course Humber Course Hame Requests Size

4 A ET] kb
[ [ [ I [ I [ ~ |
55 anizh 30

b ) D
111 26 @ O
222 Algebra 12 a8 O
333 Bidlagy 11 2 ® O
444 Bidlogy 12 1 O Ll

To generate a student subset for first-choice requests for that course
(scheduled or not):

1 In the Course Main window, right-double-click a course.

2 The view changes to the Students Main window, and shows the Student
Subset with the number of students that meet the criterion.

To select individual students, use the checkboxes, or, to select all
students, shift-click an unselected checkbox.

To print the selected students, choose Print from the System menu.
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To generate a Student Subset for requests for that course which have not
yet been filled:

1 In the Course Main window, highlight a course and choose Wait List
from the Lists menu.

2 The view changes to the Students Main window, and shows the Student
Subset with the number of students that meet the criterion.

To select individual students, use the checkboxes, or, to select all
students, shift-click an unselected checkbox.

To print the selected students, choose Print from the System menu.

Generating Reports about Requests

Course Request Tally Report. For selected courses, the Course Request
Tally report from the Reports menu displays the total number of requests by
gender and by grade.

Student Requests Report. For selected students, the Student Requests report
from the Reports menu lists name, grade, student number, and requests,
including required or elective, and prerequisite, co-requisite, and gender
requirements.

Wait Lists Report. For selected courses, the Wait Lists report from the
Reports menu creates a numbered list of students waiting to be scheduled,
the total number of requests for each course and the percentage of requests
filled.

Check the Reports menu for the report you need. See “Printing Reports” on
page 96 for more information.

Working with Other Schools

If you don’t need to schedule classes at other schools, or schedule students
from other schools, skip this section.

If students from your school attend other schools or if students from other
schools attend your school, use this section to schedule their information
differently. Enter classes from other schools into your school timetable
manually or by importing them using Data Transfer from the File menu.

Schedule students into classes taught in other schools:
e  manually
e with Assign Students from the Schedule menu

e use Data Transfer from the File menu to import student schedules from
another school your students attend, and to transfer those classes into
student timetables in your database

If you use District Data Integrator, or another application for data transfer,
please refer to the appropriate guide for information.
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Considerations:

Manually schedule students into any classes they need that aren’t
already requested. Build the rest of your student timetables normally.

Before printing timetables, select “Show All District Items” in
Preferences from the Edit menu. The status of the Show All District
Items setting also appears in the Scheduler Information dialog.

Use Reservation Labels such as “Off Campus” when students are not
scheduled at your school. See the School Setup Guide for setting up
Scheduler reservation labels.

Two options that work only if schools run identical schedules:

If you can, use Data Transfer from the File menu to import the
timetables of students taking classes at other schools. Those timetables
contain only the classes at the other schools. The rest of the timetable is
blank. Fill with Assign Students.

If you schedule students from other schools into classes at your school,
you can export their timetables with Data Transfer from the File menu.

To schedule classes or students from other schools:

1

From the other school, find out what classes your students will be
taking, when they are taught, in which rooms, and with which teachers.

In School Setup, enter the other schools in School Names from the
School menu.

In the Room Setup from the Rooms menu, enter the rooms in the other
schools that those courses are taught in. Correct the School ID and
select Yes for Scheduler.

If courses have not been entered, enter all necessary course information
in Course Details as you did for your own courses.

In the Scheduler tab, if the course is not taught in your school, select
Yes for Use in Scheduler and Yes for District Use Only.

In the Periods tab, enter only the No. of unique blocks.
In the Lists tab, enter all information except Room Preferences.

In Teacher Details, enter the teachers from other schools. Select the
correct School ID in the Personal tab.

In the Scheduler tab, enter only Teacher as the Scheduling Teacher
Type.

In Student Details, enter the students from other schools attending
classes at your school. Enter the correct Home School in the
Enrollment tab.

In Scheduler, choose Preferences from the Edit menu, then choose
Scheduler from the Edit menu. Select Show All District Items. This
determines whether rooms, courses, classes, and teachers from other
schools appear in Scheduler. Students from other schools always
appear.
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7 If you have determined which sections these students will take or if you
will import timetables for students attending classes in other schools,
don’t enter requests for those courses. Schedule them manually.

If you will schedule with Assign Students, enter student requests for
students from other schools who take classes in your school and for
students from your school taking classes in other schools.

8 Enter the rest of the student requests, set sections, and load teachers
normally. Create Timetable will not schedule classes into rooms in
other schools. So immediately before running Create Timetable, either
manually schedule or use Data Transfer from the File menu to import
schedules for all classes taught in rooms in other schools, if master
schedules are identical.

9  Lock those classes and create your school timetable normally.

Displaying Other School’s Data
Scheduler Preferences control the display of data for other schools.

From the Edit menu, choose Preferences, then choose Scheduler from the
Edit menu. Select Show All District Items to display:

e teachers assigned to other schools in Details
e rooms assigned to other schools in School Setup

e courses that have Yes entered in their District Use Only fields in the
Scheduler tab in Details

e classes that are either sections of District Use Only courses or that are
scheduled into rooms in other schools

Student records from other schools are always displayed. To display school
names in the Students Main window, select in the third or fourth column.

Step 2: Setting Sections

When you have entered all course requests, you are ready to create classes,
also called sections, for the courses at your school.

If you have run New Schedule from the Schedule menu, you don’t have any
sections. Otherwise sections from the previous year are retained. You can
use the existing sections or delete them and create new sections.

Automatically Creating Sections

To automatically create sections for your courses, choose Set Sections from
the Schedule menu. New sections are created based on:

e the number of requests for each course

e the average of the minimum and maximum class sizes set in Course
Details
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When the process is complete, the Sections window appears.

If you use Fragmented course requests, you should check that the correct
number of sections have been created for each term. See “Scheduling
Fragmented Course Requests” on page 71.
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When sections already exist, you cannot use Set Sections. To access your
Sections window to view or edit its contents, choose Sections from the
Windows menu.

Use the VCR buttons in the top right area to choose either “Sections Set Per
Term” or “Course Request Totals Per Term.”

If you make changes to student requests or class size limits in Course
Details, you can manually adjust class information in the Sections window.

After running Set Sections, you might need to edit the number of sections
created, the term in which each section is taught, or the section number
assigned.

Examining the Set Sections Results

The Sections window appears after your sections have been created. Check
each course and each term to be sure that there are enough sections based
on its requests.

This window displays course information in the top half, and class
information for the highlighted course in the bottom half.

Use the VCR buttons in the second and third columns to display problems,
scheduling, requests, and other information.

Use the VCR buttons in the fourth column to display Sections Set Per Term
or Course Request Totals Per Term.
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Automatically Resetting Sections

If you make changes to student requests or to class size limits in Course
Details, you can either manually edit class information in the Set Sections
window or rebuild all of your sections.

To automatically reset all sections:
e  From the Schedule menu, choose New Schedule.

Aside from student requests, existing scheduling data will be lost.

Editing Section Information

After setting sections, you might have to adjust the number of classes, the
terms in which they are taught, or section numbering.

You will have to create classes by adding them if you are manually
scheduling your school without using course requests. Every course must
have at least 1 section.

Adding and Deleting Classes
To adjust the number of sections, either add or delete classes.

Classes can be scheduled only into the terms selected in this window.
Create Timetables and manual editing cannot override these settings.
To add classes:

1 In the top list of the Sections window, double-click the course.

The number of terms and the sections must agree with the setup in
Course Details.

Click the Information bar or press F2 for information about the
highlighted course, including the course length (in terms), whether
terms must be consecutive, the terms in which the course can start, and
when it can be taught.

2 In the second and third columns of the Course Name window, use VCR
buttons to select information:

e Ratio in the top list displays the average number of students per
section, calculated as number of requests, divided by total number
of sections.

e Capacity in the bottom list indicates the smaller of the maximum
class size and, if the class has been scheduled, the room capacity.
To override capacity, type a new number.

3 Double-click a course, to add a class (section) in the lower list.

Class names are displayed in color until you highlight the number of
terms defined for the course in Course Details.

Course and Class names appear in color if there is any conflict.
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4 Change column information with the VCR buttons to check your
progress.

To check for problems, select Problem in the second or third column.
5 Click a numbered Term to select or deselect it.

Shift-click to select or deselect more than 1 term.

To delete a class:
e Highlight the class in the bottom list, then press Delete.

Be careful about which section number you delete.

To edit section numbers:

1 In the lower list, display Section in column 2 or 3 to list section
numbers.

2 In the Section column, highlight the section number and edit it.

You cannot use duplicate section numbers. New sections are
automatically given the next higher number.

Editing Terms when a Class is Taught
You can change the terms in which a class is taught.
If you are automatically scheduling, check that you set up the correct

information. The term selections you make constrain how Create Timetable
schedules your school.

If you are manually scheduling your school, set up this information for all
your classes.

Monitoring the Set Sections Process

To track progress in setting sections, use these Scheduler features.

Viewing Course Sections and Terms

Display Sections in Column 3 or 4 to show the number of sections and
terms for each course. Choose Print from the System menu to print selected
courses.

Viewing the Classes Main Window

This window lists all the classes and their section numbers. Choose Print
from the System menu to print selected classes.

Generating the Resource Check Report

For selected courses, the Resource Check report from the
Reports/Algorithm menu prints the number of classes, room preferences,
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available blocks, number of days and terms, and the minimum and
maximum class sizes used by Set Sections.

Generating the Equivalent Full Time Report

The Equivalent Full Time (EFT) report from the Reports/Special menu lists
courses by department. For each course, it lists the number of sections, the
EFT per section and the EFT required to teach all sections.

For each department, it lists the total EFT required.

At the end of the report, the total number of classes and the total EFT
required are listed.

This report is useful in determining teacher distribution in the Load
Teachers window. Set the EFT values in Course Details.

Scheduling Simultaneous Classes in the Same Room (Class Combining)

Use Class Combining from the Schedule menu to schedule more than 1
class in 1 room at the same time. For example Spanish 11 and 12 might be
taught at the same time in the same room by the same teacher.

For each course that could be combined with another:

1 In Course Details, Scheduler tab, select Yes for Allow Class
Combining.

2 To control the size of a combined class:

e Reduce class size in the Sections window under Capacity in
Scheduler.

OR
Reduce the maximum class size in Course Details.

3 In Scheduler, choose Class Combining from the Schedule menu, then
select New Group and enter a name for the group. It is a good idea to
include “Group” in the name of the group for easy identification of a
combined class. For example, you can combine Intermediate and
Advanced Spanish and call it Spanish Group.

4 Double click each class that is to be in the group.
5 Select the radio button for the class that is to represent the group.

6 Click OK.

Step 3: Loading Teachers

If you will not use the Create Timetable command, skip this section.

When you have set up sections for each course, load teachers for those
classes. By loading teachers, you establish which teachers can be scheduled
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for each class.

Loading teachers processes the teacher course preferences set in Details for
Create Timetable. For each course, a pool of teachers is created. A teacher
pool might consist of different teachers, each loaded to teach 1 or more
sections of a course, or it might consist of 1 teacher, loaded to teach every
section of the course.

Adjust loading to allow a teacher to teach several classes in each of 2 or
more courses. You might have to change the loading percentage and/or edit
specific teacher loading to do this.

Using the Load Teachers Command

If you are building your school timetable manually, you do not need to use
the Load Teachers command.

Each school year, the first time that you choose Load Teachers from the
Schedule menu, Scheduler loads teachers for your courses based on:

e teacher course preferences

e maximum blocks taught (defined in Teacher Details)
e number of sections of each course

e level of overfilling

Before loading teachers, Scheduler asks you for a percentage of overfilling.
The default is 34%. Click OK. When the process is complete, the Teaching
window appears.

For more information on overfilling, see “Editing the Overfilling
Percentage” on page 31.

¥ =c] 9 |=] E3
Algebra 11: Loaded with 1 teacher(s). 5 blockis) for 4 termis).
Arness, James: Loaded with 16 section(s). scheduled for 5. Maximum blocks: 35. Meximum consecutive penods: 7.
Left: Teachers loaded. Right: Number of sections.
Course Name Requests 1 2 3 4 Totals
= I W I =
4 »
el el 2l ] 2l 2l | 2/ 7
Algebra 12 36 2 2 2 2 2 2 2 2 3 3
Biology 11 20 1 1 1 1 1 1 1 1 4 4
Biology 12 28 2 2 2 2 2 2 2 2 3 8~
—_
Max Load Left: Loaded for course. Right: Total load.
Teacher Name fPref 1 2 3 4 Totals
[0 I | [ -
4 »
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Cawein. Tich A 35 0 0 3 0 3 0 3 0 3 0 12
Dean, Boh 35 0 0 3 0 3 0 3 0 3 0 12
Dactor. Heinrich 35 0 0 0 0 0 0 0 0 0 0 0
Doctor, Heinrich 35 1] 1] 0 1] 0 1] 1] 1] 1] 1] 1]
Domaoney. Dennis 35 0 0 1 0 1 0 2 1] 2 1] [
Courses for: Left: Sections loaded. Right: Sections scheduled.
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Load Teachers does not schedule teachers. It reserves enough teachers to
teach all the sections of each course. Teachers are scheduled when you run
Create Timetable or schedule them manually.

A teacher can be reserved for 1 or more sections of a course.

Editing the Overfilling Percentage

Scheduler can load more teachers for a course than are needed to teach it.
Overfilling means that when you run Create Timetable and a teacher loaded
for a course can’t teach it because of timetable conflicts, another teacher
can be scheduled.

To change the number of extra teachers loaded:

1 From the Schedule menu, choose Load Teachers.

2 Change the Teacher Overfilling percentage.

Optimizing the Overfill
The optimum overfill for most schools is either 0% or 34%.

Set the overfill to 0% if you know the courses each teacher must teach. If
you increase the overfill, teachers might be assigned to courses for which
they have a low preference, or enough teachers might not be available for
all classes.

If there is flexibility in the courses teachers teach, set the overfill to 34%.
An overfill of 34% loads 4 teachers for every 3 sections, so a section can be
scheduled whenever any of the 4 teachers is available.

Re-loading Teachers

After you have loaded teachers, whenever you choose Load Teachers from
the Schedule menu, you are asked if you want to overwrite your previous
work.

If you change the numbers of sections in any of the following, you can
either manually adjust information in the Teaching window or re-load
teachers.

e  Set Sections window
e Course preferences in Teacher Details

e Teacher block maximums in School Setup or Teacher Details

To re-load teachers:
1  From the Schedule menu, choose Load Teachers.
2 In the confirmation dialog, click OK.

3 Enter an Overfilling percentage, then click OK.
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Examining Teacher Loading Results

After you load or reload teachers, the Teaching window opens. You can
also open the Teaching window by choosing Teaching from the Windows
menu.

The Teaching window displays course information in the top section,
teacher information in the middle section, and the courses to be taught by
the highlighted teacher in the bottom section.

Check the results displayed in the middle and lower lists to be sure that
each course has enough teachers loaded, and that teachers have a balanced
teaching load.

The information bar at the top of the Teaching window gives loading
information for the highlighted course and teacher.

E¥ Teaching [SchedulerSg o] 0] %]
Algebra 11: Loaded with T teacher(s). § block(s) for 4 term(s).
Amess, James: Loaded with 16 section(s), scheduled for 5. Maximum blocks: 35, Maximum consecutive periods: 7.
Left: Teachers loaded. Right: Number of sections.
Course Name Requests 1 2 3 4 Totals
] I | [ -
4 +
Algebra12 36 H 2 2 H H 2 2 H ]
Biologpy 11 20 1 1 1 1 1 1 1 1 4 4
Biology 12 25 H 4 4 H H 2 2 2 3 3k
Max Load Left: Loaded for course. Right: Total load.
Teacher Name {Pref 1 2 3 4 Totals
I 1 ]l I -
] » —]
I I i, m
Cawein, Tich A, 35 1} 1} 3 1} 3 1} 3 1} 3 1} 12—
Diean. Boh 35 1] 0 3 1] 3 0 3 1] 3 0 12z
Daoctar, Heinrich 35 ] 0 ] ] 0 0 ] ] 0 0 ]
Doctar, Heinrich 35 0 0 0 0 0 0 0 0 0 0 0
Domoney, Dennis 35 1] 0 1 1] 1 0 2 0 2 0 [ R
Courses for: Left: Sections loaded. Right: Sections scheduled.
Amess. James Req 1 2 3 4 Totals
| 1 ] I -
[ » =)
Algebral2 36 H 1] 2 0 H 1] 2 0 g 1]

Reading the List of Courses (View Only)

Use the second column to display course information, including the number
of sections, number of requests, and number of students scheduled.

Each term has 2 columns: number of teachers loaded at left, number of
sections to be taught at right.

The number of teachers loaded, and the number of sections taught totaled
for all terms. Number of teachers loaded should be equal to or greater than
number of sections taught.

Any course name in red means the number of teachers loaded is less than
the number of sections. Without enough teachers, Create Timetable cannot
fully schedule that course. Unless you plan to manually schedule teachers,
load more teachers.
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Reading the List of Teachers

These totals are term totals, which are not the same as a total of the number
of sections of a course that teachers are loaded or scheduled for, unless all
your courses are 1 term long.

You can manually load teachers by selecting the course and double-clicking
the teacher name.

Reading the List of Teacher’s Courses (View Only)
The bottom list reports the courses that the teacher prefers, is loaded for, or
is scheduled to teach.

Double-click a course in the bottom section to highlight it in the top
section.

Editing Teacher Loading

Set up all available teachers for each course.

The more teachers loaded for a course, the better chance each class will be
scheduled.

When you edit teacher loading, your changes are saved and the section
totals are updated as you edit.
To edit teacher loading:
1 From the Windows menu, choose Teaching.

The bottom part of the window shows the course loading for a teacher.
2 In the top list, highlight a course to edit its loading.

3 In the teacher list, click the left number in a term column, then type a
number. Press Tab to move to the next term.

Every time in each term that a teacher is loaded for a course section,
the total for the term and for the year is increased. See the Totals
column of the teacher list to check totals.

4 To load a teacher once more in each term that the highlighted course is
taught, double-click the teacher’s name.

Monitoring the Teacher Loading Process

To track progress when loading teachers, use these Scheduler reports.

Teacher Loading Report. For selected teachers, choose Teacher Loading
from the Reports/Algorithm menu to print the maximum block load and all
course preferences, the level of preference, the courses the teacher is loaded
for, the number of sections loaded, the courses scheduled into, and the
number of sections scheduled.

Course Loading Report. The Course Loading report from the
Reports/Algorithm menu describes preference for the course, the numbers

Scheduling Your School e Step 3: Loading Teachers 33



Win School Scheduler

of terms, sections and blocks loaded, and numbers of sections and blocks
scheduled.

Resource Check Report. For selected courses, choose Resource Check
from the Reports/Algorithm menu to show teachers loaded for each course,
their level of preference for the course, the number of times they are loaded
in each term, and the rooms in which they can teach. Use this report to
check that teachers have compatible room preferences for the courses for
which they are loaded.

Equivalent Full Time Report. The Equivalent Full Time (EFT) report from
the Reports/Special menu lists all courses by department. For each course,
it lists the number of sections, the EFT per section and EFT required to
teach all sections. For each department, the report lists the total required
EFT. At the end of the report are total sections, and total required EFT.

Special Courses Report. Choose Special Courses from the
Reports/Algorithm menu to find courses in linked groups, or that require all
sections taught in the same blocks.

If all sections of a course must be taught at the same time, the number of
different teachers loaded for the course must be equal to or greater than the
number of sections in the course.

Classes in linked groups are taught at the same time, so check that you have
different teachers loaded for each class.

To schedule 1 teacher into 2 classes at the same time:

e Use Class Combining or use Resource Mapping as described in the
Win School System Administrator Guide.

e If you have linked 2 or more courses using clones that are taught in the
same period, check that you have cloned teachers loaded for each class.

Establishing Student Clusters
Clusters may be created for several reasons and in several ways:

e A cluster can be scheduled for 1 section of a course reserved for that
cluster. This results in each class having a different roster, but all the
students in 1 cluster take the same limited group of required classes.
This is particularly useful with Team Teaching.

e A specific program and grade can have only 1 cluster, reserving
sections of required courses for students in that program and grade.

e Define clusters by multi-pasting classes to groups of students. This is
the easiest procedure for simple timetables.

o Select a cluster to minimize conflicts when electives and cluster
courses are scheduled at the same times in the day.

Student clusters are created automatically in Scheduler.
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Before you can create clusters and teams in Scheduler:

1
2

In the Details module, identify courses by program, for clustering.

Make a list of the courses that clustered students take together in each
program at each grade level.

In Details, for each course in which you want student clusters:
e In the Scheduler tab, set Student Clusters to Yes.

e In the Lists tab, Required view, include each normal program that
needs that course in its clusters.

Loading Teaching Teams for Student Clusters

Team teaching requires student clusters, but student clusters do not require
team teaching. Before loading teaching teams:

In Details, establish that students can be clustered.
In Details, establish teaching teams.

In Scheduler, load the teams.

To load teaching teams:

1
2
3

4

Make sure you have entered requests, set sections, and loaded teachers.
From the Schedule menu, choose Clusters & Teams.

Select a Normal Program in the top left section. The courses for the
clusters for that program display in the lower part of the dialog.

The lower part of the dialog shows the Cluster numbers. If you change
the Cluster numbers to be the same number, then Scheduler will
randomly assign students into 1 of those clusters.

Clusters & Teams m
Hormal Program Students ITgam1 ;I oK I
rs
Teacher Name Teams Carmee]
Academic 12 27 _Coreel |
Yocational 11 20 ke |
acational 12 15 Marcos, Imelda 1
Advanced Placement 11 E Load... |
Advanced Placement 12 7
N - Delete |
Cluster | 1 Cluster | 2 Cluster | 3
Courses Requests Teams: 3 Teams: 3 Teams: 3
Tt v ]
4 y [ =
1 1 1
Biology 11 41 Fickle |1 Fickle |1 Fickle
Biology Lab 11 301 Wioo 1 Wioo 1 Won
Computer Science 11 4011 1 1
v

From the All Teachers popup menu in the top right, select a Team. The
names of the teachers in that team, and the teams each teacher belongs
to, are displayed below.
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5 In the lower part of the dialog, replace the zeros with the Section
number for each team, and click in the right-hand column beside the
section number, then double-click a teacher name to enter it.

6 In the upper part of the dialog, edit the Cluster numbers to create larger
clusters of students.

7 Later, when you assign students, select the “Schedule students into
clusters” checkbox. Students must have a grade and program assigned.

The Student Clusters report lists all the students in each cluster and
their classes. Off Team appears in the row for any class not in that
cluster.

You can set up your schedule so classes are taught in different periods
instead of during the same period every day. By making its own version of
the Timetable Structure you set up in School Setup, as shown in the
following figure, Period Scrambling randomly rearranges the blocks each
day.

Edit/Display Scrambling |:| Edit/Display Scrambling

8:30 AM
9:15 AM
10:00 AM
11:00 AM
11:45 AM
1:15 PM
2:00 PM
2:45 PM

Periods Scheduler Timetable School Setup Timetable
M T W T F M T W T F
> 915AM| 1 A O V AB AH |1 A 1 Q AG
> 1000AM| 2 B L X AD AG|2 B J R Z AH
> 1045AM | 3 3 K S AA Al
> 1145AM| 4 D M Q AF Al [4 D L T AB
> 1230PM| 5 E K R AE AL |5 E M U AC AK
> 200PM| 6 F P T Z AK |6 F V AD AL
> 245PM| 7 G 1 U AA AN |7 G O AE AM
> 330PM| 8 H J S AC AM|[8 H P X AF AN

Scrambled Period Mapping
(periods relative to Monday)

M T W T F

Use the Scrambled Period Mapping | 1 1 7 4 2

table (available in the Class | 2 2 8 5 6 1

Timetable Report) to translate | 3 5 8 7 4
between the two timetables. | 4 4 2 6 1

The cells’ geographical arrangement | 5 5 4 7 8 6

follows the School Setup pattern, | 6 6 1 2 5

and their contents describe their | 7 7 1 5 8

Scheduler periods. | 8 8 6 2 4 7

To scramble periods:

1 In School Setup, choose Timetable Structure from the Scheduler menu,
and give every period a different block letter.

2 In the Periods tab in Course Details, set “Same periods each day” to
Yes for all courses.

3 In Scheduler, enter requests, set sections, and load teachers.
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4 To generate a scrambled timetable, choose Scramble Periods from the
Schedule menu.

5 If some courses use Consecutive Blocks or Following Triplets, select
Doubles Together.

6  From the Edit menu, choose Preferences. In the Periods Scrambling
Display section, choose the Show Scrambled Periods radio button.
Close the Preferences dialog and save the changes.

7 To view the scrambling pattern, select a class in the Classes view, then
choose Class from the Reports/Timetable menu.

8 To change the scrambling pattern, re-do steps 4 and 5.

To change display and print options for scrambled periods:
1 From the Edit menu, choose Preferences.

2 Make a selection in the Period Scrambling Display section, then choose
Save from the File menu, and close the Preferences dialog.

Select To show When to use it

Show Block To see when classes will actually meet,
Actual structure that select this preference before printing
Periods

appears in all timetables for distribution to students
other modules | and staff.

When this preference is selected, Actual
Periods appears in the School Timetable
and Student Timetable window titles.

Show Block When building the school timetable,
ﬁg:?on;ts)led structure that schedule classes into the same period
appears only each day to make them follow the
in Scheduler scrambling pattern consistently.

You might also find this option helpful
when editing student timetables.

When this preference is selected,
Scrambled Periods appears in the
School Timetable and Student
Timetable window titles.

Step 4: Creating the School Timetable

After loading teachers for all classes, you can create the school timetable.

When your scheduling is done, before printing timetables, select Show
Actual Periods in Preferences so that timetables appear in the order in
which they will be taught.
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The general procedures for creating the school timetable are:
1 Create the Conflict Matrix.
2 Reserve teachers and rooms.

See “School Timetable” on page 90 for detailed information about
using the School Timetable window.

To prevent a teacher or room from being scheduled during a specific
scheduling block, reserve it.

3 Manually schedule and lock classes.

Manually schedule and lock any class that must be taught during a
specific period. If your timetable is pre-determined, you don’t have to
perform any procedures after this one.

4  Run the Create Timetable process to automatically schedule classes.

The Create Timetable process includes running a pre-check, fixing
problems, and running a ‘finishing’ scheduling run.

Although these steps are in chronological order, you will need to repeat
some procedures to assemble the timetable.

Generating the Conflict Matrix

If you are manually scheduling some courses before using Create
Timetable, generate the Conflict Matrix. Otherwise, Create Timetable
automatically generates the Conflict Matrix.

For specific information about what the Conflict Matrix displays, see
“Conflict Matrix” on page 98.

To generate the Conflict Matrix for specific terms, see “Generating the
Term-Based Conflict Matrix Report” on page 75.

To generate the Conflict Matrix:

1  From the Windows menu, choose Conflict Matrix.

2 From the System menu, choose Print.

3 In the dialog that appears, choose whether you want matrix or list
format.

Matrix format is a grid similar to what you see on screen. List format
lists the courses and their conflicts.

If you deselect matrix format, the report is printed in list format. You
can choose whether to print single-section courses only. While single-
section courses consume less memory, they are most affected by
conflicts. For example, students who request 2 single-section classes
will get only 1 of the classes if both are scheduled for the same time.
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Reserving Teachers and Rooms

If any room or teacher has to be reserved for any reason, reserve it before
using Create Timetable. Use reservation labels to prevent a room or teacher
from being assigned to a class at a particular time.

Set up reservation labels, such as Counseling or Study Hall in School
Setup. When a room or teacher is reserved, it cannot be scheduled during
that time. For example, a room might be needed for a regular meeting or a
teacher might only work mornings.

To reserve a room or teacher:

1  From the Windows menu, choose School Timetable.

2 In the Timetable for section, select Teacher or Room.

3 In the Enter by section, select the period of time.

For any timeframe except Year, select a term in the Timetable Term
section.

4 Highlight an item in Teacher Name or Room Number.
5 Highlight a label in Reserve Label.

6  Double-click the appropriate cell in the Teacher or Room Timetable in
the lower list.

To clear a reservation:
1  From the Windows menu, choose School Timetable.
2 In the Timetable for section, select Teacher or Room.

3 In the Enter by section, select the period of time.
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For any timeframe except Year, select a term in the Timetable Term
section.

4 Highlight an item in Teacher Name or Room Number.
5 In the timetable in the lower list, highlight the cell to be cleared.
6 Press Delete.

To clear reservation labels from selected room or teacher timetables:

1 In the Teachers or Rooms view of the Main window, select the
teacher(s) or room(s).

2 From the Schedule menu, choose Clear.

3 Select an option from the Clear dialog. See “Clear” on page 82 for
more information.

Manually Scheduling Classes

If you use automatic scheduling as well as manual scheduling, lock each
class or Create Timetable will de-schedule your work. Before running
Create Timetable, manually schedule and lock any classes that must be
taught during a specific period.

If you are manually scheduling all your classes, you do not have to lock
them.

Do not schedule a teacher into too many blocks or consecutive blocks.
Manual scheduling overrides the teacher block information set in School
Setup and Details.

For information on locking classes, see “Locking or Unlocking Classes” on
page 42.

See “School Timetable” on page 90 for detailed information about using the
School Timetable window.

To manually schedule a class:
1 From the Windows menu, choose School Timetable.
2 In the Timetable for section, select Classes.
3 In the Enter by section, select the timeframe.
To schedule a class into the same periods for all terms, select Year.
4 In the Class Display Mode section, select Room / Teacher.
5 Highlight:
e aclass
e ateacher for that class

e aroom for that class and teacher
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In the Class Timetable, double-click:
e ablock or period

OR

a cell for a term or year

Scheduled cells display marks at the left. When a class is fully
scheduled, the name turns from red to black.

To remove a class from the schedule:

To delete a class from 1 block or period, select Block or Period in the
Enter by section. Highlight the block or period in the bottom part of the
window and press Delete.

To delete a class from all scheduled periods, select Term or Year in the
Enter by section. Highlight a cell in the bottom part of the window and
press Delete.

If you de-schedule any block or time for a class, all students scheduled to
take the class are removed from the schedule for that block. If they have a
request for that course, they are placed on the Wait List.

See also “Removing Classes from the School Timetable” on page 51.

Symbols in the Class Timetable Area

The timetable in the lower third of the School Timetable window displays
the following symbols:

Triangle You can schedule the class highlighted in the Class Name

list in this time slot, according to the periods established
for the course in Details. You can actually schedule the
class in any time slot, regardless of whether it displays a
triangle.

The teacher highlighted in the Teacher Name list is busy
in this time slot.

T is blue or gray when the teacher is scheduled for another
class in that time slot.

T is black or yellow when the teacher has a reservation
label in that time slot.

The room highlighted in the Room Number list is busy in
this time slot.

R is red or green when another class is scheduled in the
room in that time slot.

R is black or yellow when the room has a reservation label
in that time slot.

Penod Day 1

] |

100/ Amess N
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You cannot schedule classes into periods/blocks which display T or R.
Check the relevant room or teacher timetables to check what is creating the
conflict, and make changes as required. You will have to reschedule 1 of
the conflicting classes or change your room/teacher assignments.

Names of combined classes are bold in the lower part of the window.

Using Different Class Display Modes in the School Timetable
Window

We recommend you select Classes in the Timetable for section, and use
Class Display Mode while you are manually scheduling. Run the Conflict
Matrix from the Windows menu before using these displays.

When you are manually scheduling, use Difficulties, Superimpose, and
Superimpose All in the Class Display Mode section to help produce the
fewest request conflicts with already-scheduled courses.

Clazs Display Mode:
Boom/T eacher Blocks Superimpoze | Superimp. Al Difficulties |

Class Display Mode options:

e Room/Teacher: displays teacher and room scheduled for the
highlighted class.

e Blocks: displays block letters to help schedule repeating blocks.

e Superimpose: displays scheduled courses that have request conflicts
with the highlighted class. These courses have been requested by a
student who has also requested the highlighted class. To check for
request conflicts between specific courses and the highlighted class,
select those courses in the Courses Main window, then select
Superimpose.

e Superimpose All: displays other courses requested by students
requesting the highlighted course. If you select Superimpose, this view
displays the same information but for only the courses you select in the
List of Courses window.

e Difficulties: lists request conflicts with scheduled classes. Schedule the
class in the period with the lowest difficulty.

Locking or Unlocking Classes

You can only lock a class after you have scheduled it into a room with a
teacher. Before running Create Timetable, manually schedule and lock any
classes that must be taught during a specific period.

If you use automatic scheduling as well as manual scheduling, lock each
class or Create Timetable will de-schedule your work.

If you are manually scheduling all your classes, you do not have to lock
them.
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To lock or unlock a particular class:

1

In the School Timetable window, highlight a class in the Class Name
list.

Click the Lock button above and to the left of the Class Name list. A
padlock icon appears to the left of the locked class.

Lock I |Biu:u||:ug_l.J 12 (1] Room: 120 Teacher: Dean, Bob Meeting: 5af5 Fo

Terms Offered

T | [N

Class Hame

.

i ] Advy, Spanish [1] b
Algebra 11 1] 142

i} Algebra 11 [2] 142
Algebra 12 1] 142
Algebra 12 [2] 142

Biology 11 [1]
Biology 12 [1]
Biology Lab 11 (1]

Bookkeeping 11 [1) 3
Calculuz 12 1] 142 ll

To lock or unlock all scheduled classes by term:

1

In the Classes Main window, choose Lock Classes from the Schedule
menu.

Select (darken) the terms in which you wish to lock or unlock classes.

Click Lock or Unlock. All classes scheduled in the specified term(s)
will be affected. In the Classes Main window, padlock icons appear in
the left margin beside locked classes.

Tips for Scheduling Classes

Use the VCR buttons to check which terms a class is taught or offered.

When you want to automatically schedule classes for the year, start
scheduling with the first term in which the class is taught. The Sched
Year button at the left copies scheduling information only to those
terms which follow the current term.

To schedule a class without a teacher or room, select N/A for the name.
N/A will appear in the timetable instead of the teacher or room name. If
the class is scheduled, but has neither a teacher nor a room, N/A / N/A
appears in the block(s) in which the class is scheduled.

If a teacher or room is busy, and Scheduler displays an alert message,
check the relevant room or teacher timetables. Use options in the
Timetable for section to find the conflict. Make changes as required.
You will have to reschedule 1 of the conflicting classes or change room
or teacher assignments.

If you de-schedule any block or time for a class, all students scheduled
to take the class are removed from the schedule for that block. If they
have a request for that course, they are placed on the Wait List.
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Using Key-and-mouse shortcuts
In Class Names, control-click to find the first unscheduled class.

With a class highlighted, control-click the Teacher Name list to find the
first teacher with a preference for that course.

Control-click Room Names to find the first room with preference for that
course and teacher.

Using Create Timetable
Create Timetable is the automatic process for scheduling.

The time required for Create Timetable to schedule a school depends on
these factors:

e the type of PC you use

e whether the PC is running on a network

e the number of blocks, classes, teachers, and rooms

e the constraints you have set, and the complexity of your timetable

To schedule your school, run Create Timetable several times and between
runs, lock the classes with schedules you like.

Create Timetable m

¥ Lookahead — Select teacher for class

[ Scheduls only selected courses & From Courss Preferences
" From Load Teachers

[ Keep teachers in homerooms

[v Ignore rooms and teachers
— Start zcheduling with:

Allowable Potential Conflicts IEIE!EI ¥ Special Courses

" Momal Courses
Pre-Check I
—%'hen problem occurs ————
Schedule
" Stop

Optimize | " Pause
% Continue
Cancel |

Read the Win School System Administrator Guide for tips on how to
approach the Create Timetable process for each scheduling run.

See “Create Timetable” on page 83 for a complete description of the Create
Timetable dialog.
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Pre-checking Scheduling
Pre-Check initializes your data by:

Removing students from unlocked classes and unscheduling those
classes from the school timetable.

Determining teachers available for courses.

Examining classes.

This process can take some time, depending on the number and size of
classes that must be cleared.

Pre-Check doesn’t schedule classes. It examines the number of blocks and
terms in which classes will be taught in relation to the rooms and teachers
available for those classes, then alerts you to possible conflicts. This allows
you to fix problems before an actual scheduling run.

Pre-Check helps you to avoid scheduling many classes, then discovering
unworkable room/teacher selections or Course Details settings that prevent
you from completing your school timetable.

To run pre-check:

1
2
3

Lock classes you don’t want changed or removed.
From the Schedule menu, choose Create Timetable.
Select options in the Create Timetable dialog, as required:

Lookahead: looks at available rooms and teachers, and checks all
sections of a course to find the best room/teacher combination.
Lookahead is useful only for courses with more than 1 section.

Schedule only selected courses: based on courses selected in the
Courses Main window. Use to schedule courses in groups, according to
priority. Useful for resources in very high demand, such as a gym or a
lab, and single-section courses.

Keep teachers in homerooms: based on homerooms defined in Teacher
Details. Useful for elementary school teachers in 1 room only. When
teacher room preferences are this restrictive, course room preferences
should be very broad. You should be able to set most course room
preferences to Any room.

Ignore rooms and teachers: ignores room and teacher preferences.

Allowable Potential Conflicts: looks at the number of conflicting
requests for the class before determining that the class cannot be
scheduled. Student requests, teachers, and physical resources are all
considered.

From Course Preferences: selects teachers for classes based on
availability for that class and Preferred Courses in Details.

OR

From Load Teachers: selects teachers for classes based on the teachers
loaded.
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Optimize: does not apply to Pre-Check.
4 Click Pre-Check.

5 The Pre-Check for Create Timetables report window opens, listing the
name of each class that is locked or has problems with room or teacher
selections, and the nature of the problem. The number of problems
found and the total number of classes examined appear at the end of the
list.

6 Resolve problems and re-run Pre-Check until no more problems
appear.

Fixing Problems Discovered by Pre-checking
To investigate problems with room or teacher selections:

e In Scheduler, choose Resource Check from the Reports/Algorithm
menu. Check teachers loaded for each course, their level of preference
for the course, the number of times they are loaded in each term, and
the rooms in which they can teach. Check that teachers have
compatible room preferences for the courses for which they are loaded.

Check the number of classes, room preferences, available blocks,
number of days and terms, and the minimum and maximum class sizes
used by Set Sections.

e In Course or Teacher Details, check course or teacher room
preferences. Pre-Check must be able to find at least 1 common room in
the Rooms lists of the course and its teacher.

Most courses that cannot be scheduled are the result of incompatible
teacher and course room preferences.

e In Scheduler, check teacher loading in the Teaching window. If you run
Pre-Check with “Select teacher for class™ set to “From Load Teachers,”
changing a teacher’s course preferences in Teacher Details will not
have any effect on Pre-Check unless you re-load your teachers.

If you need only 1 or 2 changes, manually edit the Teaching window.

To investigate problems with block or term restrictions:

e In the Periods tab of Course Details, check Usable Blocks/Periods for
this course . Make sure this setting is not too restrictive. If a course can
only be taught at a certain time, schedule it manually and lock it.

e In the Sections window, in the second and third columns, use the VCR
buttons to choose Problem, and correct any problems.

e Check the Sections window to see that the number of terms selected in
the Terms Class Will Be Taught column matches the Course Length (in
terms) setting of the Scheduler tab in Course Details.
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Automatically Schedule

To fully automatically schedule, you must completely resolve problems
identified by pre-checking.

To schedule automatically:

1
2

From the Schedule menu, choose Create Timetable.

Select Lookahead, then set Allowable Potential Conflicts to 400.
Win School always chooses the period with the lowest number of
conflicts.

If you have a very restricted schedule, you might need to set this
number much higher, for example, 999.

Select other options.

Always start by selecting Special Courses. Create Timetable schedules
them first, then automatically continues to normal courses.

In the When problem occurs section:
e  Stop: halts the process on each problem until you resolve it.

e Pause: also stops the process on each problem. However, you can
resolve it immediately or have Create Timetable leave the class
unscheduled and continue.

e Continue: the process proceeds past all problems without stopping.
Problem classes remain unscheduled. Select Continue for
preliminary runs, to identify problems with room preferences. Go
to the School Timetable window to see what didn’t get scheduled.

If you are resuming a scheduling run after a Scheduler pause, click
Resume.

If you do not have any Special Courses or you have already scheduled
them, select Normal Courses.

Click Schedule.

If Create Timetable detects a problem, go to “Fixing Create Timetable
Problems” on page 48 and fix the problem.

When Create Timetable finds a problem, it will either stop, pause, or
continue the scheduling run, depending on the option you selected.

If you have finished using Create Timetable to schedule both Special
Courses and Normal Courses, go on to “Finishing Your School
Timetable” on page 51.

To stop Create Timetable when it is running:

Click Stop in the Create Timetable Progress window. You can also stop
the process by closing the window, but you will then lose all the
information it contains.

Scheduling Your School e Step 4: Creating the School Timetable 47



Win School Scheduler

Fixing Create Timetable Problems

If Create Timetable stops during the Special Courses phase, find the course
causing the problem, correct it using the procedures below, and resume the
Create Timetable process.

When Create Timetable Stops
Examine the Create Timetable Progress window.

The title of the window tells you the phase in progress when Create
Timetable stopped (Scheduling Special Courses or Scheduling Normal
Courses). Or if you paused or stopped Create Timetable, the bottom lines
tell you the phase being processed when it stopped, the class that could not
be scheduled, and the problem.

If you continued Create Timetable despite the problem, scroll until you
locate the problem.

A problem is usually 1 of the following:

e Teacher selections busy or too restrictive.

e Room selections busy or too restrictive.

e Room and teacher selections are too restrictive.
e Allowable potential conflicts too low.

Set it to 400 or higher, and resume Create Timetable. If it is already
high and if you manually scheduled and locked many classes, unlock
some classes and re-start Create Timetable at Special Courses.

e A single class in a Linked Group or Following Triplet or 1 of the
sections of a course that needs All Sections in the Same Blocks can’t be
scheduled, so none of the other classes in its group will be scheduled.

e (lass is partially locked.

Schedule it manually, lock it, and resume Create Timetable.

If Classes Don’t Schedule:

1  In the School Timetable, highlight the class that Create Timetable
could not schedule, then highlight each of the teachers loaded and the
rooms preferred by each teacher and the course.

2 Use the Teachers and Room Timetable for settings to look at their
schedules for possibilities. See below.

3 When the problems are resolved, click Continue.
OR
Manually schedule the class and lock it.

If the class cannot be scheduled at this time, you can leave the class
unscheduled and continue the Create Timetable process. You can
manually schedule the class later before you assign students to it.
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Either lock all your fully scheduled classes and run Create Timetable.
OR

Select only the course(s) you are working on and select the “Schedule
only selected courses” option when you run Create Timetable.

Possible reasons for problems with scheduling classes:

1

Look into the following possibilities to resolve scheduling problems:
e check that at least 1 student is requesting the course

e check that a reserved period can be changed

¢ find another term or terms in which the class can be taught

e check if a teacher, room, or block that is not allowed, but can be
used to schedule the course

e check that the number of times taught per term and number of
terms specified in Course Details is correct

e check the maximum number of blocks a teacher can teach
e check the number of consecutive blocks the teacher can teach
If that doesn’t work, try the following:

e Change course or teacher room preferences in Course or Teacher
Details.

e Change teacher loading in the Teaching window. If you run Create
Timetable with the Select teacher for class option set to “From
Load Teachers,” changing a teacher’s course preferences in
Teacher Details will not have any effect on Create Timetable
unless you re-load your teachers. If you need only 1 or 2 changes,
manually editing the Teaching window is easier.

e Change reserved periods for a teacher or room in the School
Timetable window, and for a course in Course Details.

e Change the terms in which a class is taught in the Sections
window.

If Course Can’t Be Scheduled:

1

Select the course that could not be scheduled in the Courses Main
window.

From the Reports/Algorithms menu, choose Resource Check to see if
you have given Scheduler workable preferences.

If the problem mentions teacher selections:

e Compare the number of sections of the course with the number of
teaches loaded. The teacher loading must be enough to cover all
the sections of the course.
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e How many different teachers have been loaded? The more different
teacher timetables Create Timetable can use to schedule a class, the
more likely it will succeed.

e [Ifyou’ve set “All sections in the same blocks” in Course Details,
you need to load as many different teachers as you have sections,
since they are all taught simultaneously. Either load enough
teachers or turn off “All sections in the same blocks.”

If the problem mentions room selections:

e Compare the preferred rooms for the course and the teacher to see
if there is an overlap. Create Timetable must find at least 1 room
preferred by both. Preferences such as “101 -Art Room” and “Any
Classroom” are incompatible. See if there are any other rooms you
can add to 1 or both lists of preferences. To change the preferences
of either, return to Course or Teacher Details.

e If the course must be taught with “All sections in the same blocks,”
there must be preferences for as many different rooms as sections.
Check that different teachers can teach in different rooms. In
Details, make room preference changes for courses and teachers.

If the problem is that allowable potential conflicts is too low, and it’s at
400, try increasing the number. If that doesn’t work, you might have to
increase the number of usable blocks for the course.

4 View the course in School Timetable from the Windows menu.

5 Double-click the class that Create Timetable could not schedule to
check each of the teachers loaded and the rooms.

6  To check rooms preferred by each teacher and the course, use the
Teacher Main window and Room Main window to look at their
schedules. You might find a reserved period that can be changed to
allow the course to be scheduled. Consider changing the terms, blocks,
rooms, or teachers set up for the course in Details.

7  When you have determined the source of the problem, resolve it using
the following solutions:

e Change course or teacher room preferences in Details.

e If you change teacher course preferences, re-load teachers or edit
teacher loading in the Load Teachers window.

e Change reserved periods for a teacher or room in the School
Timetable window and for a course in Course Details.

e Change the terms in which a class is taught in the Set Sections
window.

e Manually schedule and lock the class.

e [f the class cannot be scheduled at this time for other reasons
(perhaps you are awaiting approval to hire a new teacher or
purchase a new portable classroom) you can leave the class
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8

unscheduled, and lock it. Schedule the class manually before
assigning students to it.

From the Schedule menu, choose Create Timetable, and click Schedule.

Finishing Your School Timetable

When Create Timetable has finished building your timetable, you should
optimize the timetable.

Do not skip the final optimization. It can make a big difference in results.

To optimize your school timetable:

1
2

From the Windows menu, choose School Timetable.

Check the Class Name list for unscheduled classes. Create Timetable
might have passed over unscheduled classes if you either locked
unscheduled classes or set “When problem occurs” to Continue.

Schedule unscheduled classes using the School Timetable window.

Lock classes you don’t want changed, even if there may be a better spot
for them in the timetable.

From the Schedule menu, choose Create Timetable. Click Optimize.

Removing Classes from the School Timetable

You can remove some classes from the school timetable and then schedule
those classes into the timetable, either automatically or manually.

Unlocked classes are removed from the school timetable by Create
Timetable. Classes can also be removed from the school timetable using the
Clear dialog from the Schedule menu.

To remove classes from the School Timetable:

1

In the Classes Main window, select the classes to be removed from the
schedule.

From the Schedule menu, choose Clear.

In the Clear dialog, select “Clear selected classes from school and
student timetables.”

If you also want locked classes to be cleared, select Modify Locked
Classes.
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” Clear selected courzes from student request lists

" Clear selected classes from student timetables

" Clear selected courses from school and student timetables
% Clear selected classes from school and student timetables
" Clear reservation labels fram selected rooms' timetables

™ Clear reservation labels from selected teachers' imetables

I |Beplace firstchice request withits linked &lterate

Iv Modify Locked Classes [ &lIsbels but "Hesemead!

Clear Terms
HHA :|:|s

Clear Cancel |

4 In Clear Terms, select (darken) terms to be cleared, then click Clear.
Classes not scheduled in the terms you select are left unchanged.

See also “Manually Scheduling Classes” on page 40.

Monitoring the Create Timetable Process

To track progress when loading teachers, use these Scheduler features.

Generating the Special Courses Report

From the Reports/Algorithm menu, choose Special Courses to get a list of
Linked Groups, Following Triplets, and courses that must have all sections
taught in the same blocks. These are the courses scheduled in Create
Timetable’s Special Courses phase. This report also includes courses
selected in the Preceding Course option in Course Details, block-restricted
courses (courses that cannot be taught in any block), and courses with extra
periods.

Viewing the Create Timetable Progress Window

As Create Timetable runs, the room and teacher combinations it examines
for each class are displayed in the Create Timetable Progress window. If the
process stops before completion, the last line displayed indicates the
problem and the class involved. If Create Timetable completes normally, a
processing summary is displayed. Page numbers refer you to the relevant
processing commentary in the body of the report.
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Viewing the Performance Window

From the Windows menu, choose Performance and click a view for
information on courses, classes, rooms, and teachers. The Courses, Classes,
and Teachers views display items from the respective lists, as well as
optional information in the second column. Use the Percent and Usage
columns to assess resource use and scheduling performance.

Usage displays a bar chart representation of the Percent figure.

Broromoce M

=W 5

Colrses Claszes Fiooms Teachers Sumnmmary

Courge Name Scheduled Percent Uszage
| I e |

-

I | |
Ady. Spanish 7 g7z (I
Algebra 11 26 86 I
Algebra12 38 100%
Bialogy 11 4 100% |
Biology 12 14 100% |
Biology Lab 11 3 100% |
Bookkeeping 11 21 e 00000
Calculus 12 38 1007 |
Chemistry 11 7 1007% |
Chermisty 12 16 100%
Computer Science 11 I 0
Dirafting 12 16 100% Ll

The figure in the Percent column has the following meaning in each view:

Courses

Classes

Rooms

Teachers

Summary

Total number of students scheduled for all sections of
the course, divided by the total number of requests for
that course.

Number of students scheduled into the class divided
by its capacity (lesser of Max. Class Size in Details
and Max. Room Size in School Setup).

Number of times the room is used divided by the
number of times the room is available (times refers to
slots in your school timetable).

Number of times the teacher is used divided by the
number of times the teacher is available (times refers
to slots in your school timetable).

Totals of scheduling results.

Sort order is determined by the order in the Main window. Print any
Performance window from the System menu.
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Generating the Block Capacities Report

From the Reports/Lists menu, choose Block Capabilities. In the Print
Options dialog, select blocks in each term. The report displays the
following:

e The Students column lists the number of students in each grade and in
the school.

e The Total Class Capacity columns list the number and percentage of
seats in classes for each grade level and in total. The percentage is the
number of seats in scheduled classes divided by the number of students.

Total Class Capacity percentage should be equal to or greater than
100%. If not, you might not have enough classes scheduled during that
block to accommodate all students. In that case, look for blocks with a
very high Total Class Capacity percentage, then in the School
Timetable (from the Windows menu), look for classes that can be
moved from the very full blocks to the under-filled blocks. Before
moving a class, display Difficulties in the School Timetable window
from Class Display Mode.

e The Seats Available columns list the number and percentage of
available seats.

e The Seats Filled columns list the number and percentage of filled seats.

=% Block Capacities Report _ O] x|
T
[(12]pae F of 16 | oo 1o _tor |
Block Capacities FReport
Chancery Academy
Block Grade Students Classes Total Class Capacity Seats Available Seats Filled
A1 a 2 1] 1] 0 0 0 1} 0
1 43 1 28 57% 16 57% 12 42%
12 51 2 100 1963 51 51% 43 49%
Total 102 3 128 125% EY 2% E1 47%
B-1 a 2 1] 1] 1% 0 0 1} 0
1 43 1 15 30% 0 0% 24 160%
12 51 a a 0% 0 0% 1} 0%
Total 102 1 15 14% i} 0% 24 160%
C5L win Schoal - Scheduler 4.0 Page 1 Tue, March 23,1999, 0336 PM

Generating the Timetable Reports

You can display reports to look at your timetable in different ways. From
the Reports/Timetable menu, choose Course, Class, Room, Student, or
Teacher. From the Reports/Special menu, choose Class Blocks or Period
Schedule.

Viewing Teacher Timetable and Room Timetable Windows
These windows display teacher and room timetables in a block grid.
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Step 5: Creating Student Timetables

Reserving Periods

When you have created your school timetable, start scheduling students.

General procedures for scheduling students:
1 Reserve periods for specific students.
2 Manually schedule students that must be in a particular section.

3 If you have entered requests, choose Assign Students from the
Schedule menu.

4  Resolve scheduling conflicts by manually scheduling unscheduled
students.

5 If you have set up study halls in each period in each term, use Assign
Study from the Schedule menu to schedule students into Study Halls in
all their unscheduled periods.

If you have students involved in special programs or performing special
duties, you can reserve periods so Assign Students will not schedule classes
into them. Periods are reserved using the reservation labels you defined in
School Setup.

To assign a reservation label:

1 From the Windows menu, choose Student Timetable, then in the
Display Mode section, choose Classes.

2 In the View Classes section, click Labels.

3 In the Enter By section, select a timeframe, then select a term from the
Timetable Term section, unless you selected Year.

4  Highlight a label in the Reserve Label list.
5 Double-click a timeslot to schedule the label.

6  Assign the label to every period in every term you need it assigned.

To delete a reservation label:

1 Highlight the block or period containing the label. Deletion is
controlled by your selection in the Enter by section.

2 Press Delete.

You can also remove reservation labels from selected room or teacher
timetables by using Clear from the Schedule menu.

Manually Scheduling 1 Student

If a student must take a specific section of a course, schedule that student
before using Assign Students from the Schedule menu to schedule all
students.
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If you are manually scheduling more than 1 student into the same class, we
recommend you use Multi-pasting as described in “Manually Scheduling
Many Students (Multi-pasting)” on page 58.

If you are manually scheduling your school, review both methods, then
choose the best approach or mix of approaches to use.

Manually Scheduling for the whole year or 1 term:

1 In the Students Main window, highlight the student name.

2 From the Windows menu, choose Student Timetable. Then in the View
Classes section, select any option except Labels.

3 In the Enter by section, select Year or Term. If you selected Term,
select the term you wish to schedule in the Timetable Term section.

4 In the Class Name list, double-click the class to be scheduled.

If the Status column shows Busy for a class, that class conflicts with a class
already scheduled in the student’s timetable. If you schedule that class, the
conflicting class is removed from the timetable entirely, regardless of the
setting in the Enter by section.

i de atable (A al Period Scheduler®g =2 _ |C|/x
Brier, Ethel Display Mode: View Classes:
Grade: 12 Clazzes Blocks | Supenmp. | | In School | In Perod | Bequested| Labels
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Requested Credits: 8.00 metable Te

Scheduled Credits: 4.00 Block | Period | Tem | Year 2131415 [

Required Creditz: 7.0 = e .

ND"‘“?' Program: Acadernic Transfer Start Date for Change: Wi
Special Program: Accelerated b ark.s 23MAR 99 Transfers

Clazz Hame Status Penod Students
[IET] | b [ a4 I e

Biology 12 (1] FRequest: PreReqBiology 11 M/ 0af 30
Calculus 12 [1] FRequest: M/ 0af 28
Calculus 12 [2] FRequest: M/ 0af 28
Chermistry 12 [1] Requests PreReq:Chemizstry 11 M 0af 30
Englzh Lang. 12 (1] Taking PreReqgEnglish 11 Jof 30
Geography 12 1] Taking Jof 35
Fhyzical Education 12 (1) Taking

Day 4

Physical Educ... 12[1] ™ Physical Educ.. 12117 Phygical Educ... 121117
Geography 12 [1]
Physical Educ... 1211] 7

Englizh Lang. 12 1] Englizh Lang. 12 1] Geography 12 (1]
Geography 12 (1] Englizh Lang. 12 1]
Geography 12 (1] Physical Educ... 12[1]
Geography 12 (1] Englizh Lang. 12 (1] Englizh Lang. 12 (1]

56 Scheduling Your School e Step 5: Creating Student Timetables



Win School Scheduler

Manually Scheduling for 1 block or period:

0 N N Lt A WD =

In the Students Main window, highlight the student name.

From the Windows menu, choose Student Timetable.

In the Display Mode section, select Classes.

In the View Classes section, select any option except Labels.

In the Enter by section, select Period or Block.

In the Timetable Term section, select the term you wish to schedule.
In the Class Name list, double-click the class to be scheduled.

In the timetable, triangles appear in the timeslots that the class meets.
Double-click a timeslot to schedule the student.

If you schedule a class into a timeslot that already contains a class, the
conflicting class is removed from all scheduled timeslots for that student. If
you entered by Term or by Year, the class is removed for the term or year,
respectively.

If you schedule a class into a block which is not in your Timetable
Structure, the class will not be displayed in the period/day timetable grid at
the bottom of the window. To see the class, select Block in the Enter by
section. The Class Name column displays the class name, and the Status
column displays Taking.

To find the next class for an unscheduled period:

In the Student Timetable window, control-left-click the empty period.
The next class taught at that time is highlighted in the Class Name
column.

OR

Highlight the empty period and click In Period in the View Classes
section. Only classes taught in that period appear in the Class Name
column.

The Teachers column shows the number of active students assigned to
a teacher in the selected year (Yr) and term (Trm). If a student is in 2
classes taught by the same teacher, that teacher is considered
responsible for 2 students.

To remove a class from a student timetable:

Highlight a block or period containing the class and press Delete.
OR
Assign Free to any periods or blocks in which the class is taught.

The class is removed from the schedule as determined by the setting in
the Enter by section.
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Tips for Manually Scheduling 1 Student

e In the School Timetable window, display all courses requested by
selecting Superimpose All in the Class Display Mode section. This
view shows you which periods have the fewest conflicts.

e In the Student Timetable window, select Superimpose in the Class
Display Mode section to display only courses requested by the student
and selected in the List of Courses. Use this view to examine problem
courses or multiple-section courses before scheduling sections for the
student.

e Display block letters to understand how single periods can be
scheduled by selecting Blocks in the Class Display Mode section.

e Use F3 and F4 to go through the student list.

e Schedule all classes that are colored red before scheduling students into
them. Those classes do not have a teacher and/or room scheduled for
all the periods or terms in which they are taught.

Manually Scheduling Many Students (Multi-pasting)

By pasting, you can schedule 1 or more students into a class. If that class
conflicts with an already scheduled class, it will not be added to the student
timetable.

You can also copy the entire timetable, or the timetable and the request list
belonging to 1 student, and give it to 1 or more other students, replacing
whatever they had.

Use this procedure when groups of students stay together during the day,
moving from class to class together.

Multi-pasting classes overrides the class capacity you set in Details.
Monitor the Students column in the Classes Main window to check that you
don’t schedule too many students into a class.

In Preferences from the Edit menu, select an option in “When Pasting
Classes” to control how conflicting classes are handled when you paste. If
you select “Remove PERIODS that conflict with paste” or “Remove
CLASSES that conflict with paste,” any classes conflicting with the class
being pasted are removed from the schedule.

YWhen Pazting Clazses
& Don't paste if class conflicts

" Remove PERIODS that conflict with paste

™ Remove CLASSES that conflict with paste

Be very cautious when changing Preferences. Changes to preferences can
cause unwanted results in student timetables.
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Assigning Students

To add to several student timetables at the same time:
1 Highlight a class in the Classes Main window.
OR

To copy a timetable and/or request list from 1 student to several others,
highlight the source student in the Students Main window.

2 From the Edit menu, choose Copy.

If you are copying a timetable and/or request list from a student, select
Requests and/or Timetable. Click OK.

3 To display the current contents of the clipboard, click the Information
icon in the title bar of any window.

4  Select the destination students in the Students Main window.
5 From the Edit menu, choose Multi-Paste. Click OK.

If the “Don’t paste if class conflicts” preference is selected, and you
paste students into a class, all students you attempt to paste are placed
in the Student Subset, and those who had conflicting classes remain
selected.

A message reports the number of students who had conflicts and were
not pasted into the class.

6 Edit timetables manually to resolve the conflicts.

7 If you are pasting classes, and you chose to overwrite conflicting
classes in Preferences, the students that were pasted-to are placed in the
Student Subset.

Assign Students from the Schedule menu fills as many unfilled course
requests as possible for selected students. Requests for required courses are
filled before electives. Classes already scheduled are not affected. If you
have scheduled any part of a requested class, that request is filled.

If you want to assign Fragmented course requests, you must remove
duplicate requests before assigning students or Schedule Credits will be
incorrect. See “Scheduling Fragmented Course Requests” on page 71.

See the Win School System Administrator Guide for tips on how to Assign
Students for each scheduling run. See also “Assign Students” on page 78
for a complete description.

To Assign Students:

1 Select some students in the Student window.

2 From the Schedule menu, choose Assign Students.

3 In the Assign Students dialog, select the options you wish to use, select
periods and terms at the bottom, then click OK.
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Assign Students m

Class Overfiling I %

b azimum time: per student [sec. eg: 30] ISD—

v Use Backtracking

™ Usze selected courses only

¥ Use altemates

[ &llow partially scheduled clazses

™ Masimum of one course per department per term

V¥ Schedule students into clusters

[ Choose sections according to Linked Groups and Following Triplets

[ Enforce prerequisite niles

Periods

Terms
B [ [ [ [ [ [ [T concel| [[ox]

Assign Students is restricted to making changes to Student Timetables
in the periods and terms you select.

4 If Assign Students fails to schedule any students in 1 or more classes,
see “Fixing Assign Students Problems” on page 61.

Tips on Assigning Students

e Select “Use Backtracking” to find the schedule that fills the most
requests. This option can be slow, so deselect it when you are not
scheduling multi-section courses.

For best results, before using this option, clear the student timetable by
choosing Clear from the Schedule menu.

e If your students have alternate requests, choose Scheduled < Requested
from the Lists menu to display a sub-set of the students who could not
get into all the courses they requested.

Select all those students, and run Assign Students again with “Use
Backtracking” deselected and “Use alternates” selected. Assign
Students schedules alternate requests into available periods.

e When setting Class Overfilling, consider the room capacity and the
maximum class size you set for each course in Details. If you set
overfilling at 10%, Assign Students can place up to 33 students in a
class whose capacity is 30. We recommend you set 10% when first
using Assign Students, then if necessary, manually remove students
near the end of your scheduling run.
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Fixing Assign Students Problems

If Assign Students places no student in 1 or more classes:

1
2

From the Schedule menu, choose Assign Students.

If “Use selected courses only” is selected, either deselect it or select all
courses in the Courses Main window.

If classes are scheduled in a term or period that is not selected in the
Assign Students dialog, Assign Students is restricted to making Student
Timetable changes in selected periods and terms.

From the Windows menu, choose School Timetable.
Classes displayed in color are not fully scheduled.

Assign Students places students in fully scheduled classes only, unless
you selected “Allow partially scheduled classes” in Assign Students.

Schedule the class or classes manually.

Select the Classes Main window. If the Students column show of 0, that
class has a capacity of 0.

Make sure Room Capacity in School Setup is correct.

Resolving Scheduling Conflicts

Assigning Study Halls

If, after running Assign Students, some students do not have a complete
timetable, resolve their scheduling problems by manually scheduling them.

When you have scheduled all classes into student timetables, you might be
left with some periods still marked Free. You can place students in Study
Hall classes in these periods.

Use Assign Study after students have been scheduled into all their classes.

To assign Study Hall:

1

In Course Details, create a Study Hall course. In the Scheduler tab,
enter 1 (one) for length. In the Periods tab, enter 1 (one) for unique
block letters, spread, and periods per day.

In Scheduler, do not enter any requests for Study Hall.

In the Main window, click the Information icon to see the number of
block-terms.

You need the minimum number of sections of Study Hall. If you have
16 blocks and 2 terms, you will need 32 sections of Study Hall to offer
it every period.

In the Sections window, manually create the required number of
sections of Study Hall. Schedule at least 1 section of Study Hall into
every period of each term.
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5 In the Students Main window, select students.

6 In Courses view, highlight the Study Hall course you created in Step 1.

7  From the Schedule menu, choose Assign Study.

Monitoring the Assign Students Process

To track progress when assigning students, use these Scheduler features.

Viewing the Performance Window

From the Windows menu, choose Performance to display performance
measures. Other parts of this report relate to the school timetable.

Indicator

Where to Find it in the Performance
Window

Number of requests by course

Courses view—Requests column

Total number of students
scheduled for all sections based
on this course

Courses view—Scheduled column

Total student requests

Summary view—Requests row

Requests that have been
scheduled

Summary view—Requests Scheduled row

Students who are scheduled into
at least as many credits as they
have requested

Summary view—~Fully Scheduled
Students row

Students with enough credits
scheduled to meeting their
program credit requirement

Summary view—Students Meeting
Requirements row

Average class size

Summary view—Average Class Size row

Average number of students that
have classes scheduled in a given
block

Summary view—Students Busy row
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Broromoce M
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Course Name Scheduled Percent Usage
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Ady. Spanish 7 g7z (I
Algebra 11 26 86 I
Algebra 12 a8 100%
Biology 11 4 100% | —
Biology 12 14 100% |
Biology Lab 11 3 1003 |
Bookkeeping 11 21 e 00000
Calculus 12 38 1007 |
Chemistry 11 7 1007% |
Chermisty 12 16 100%
Computer Science 11 I 0
Dirafting 12 16 100% Ll

Percent in the Courses view is the principal measure of scheduling success.
It represents the total number of students scheduled for all sections of the
course, divided by the total number of requests for that course.

Usage is a representation of Percent. A number of 90% or higher is very
good. Don’t expect to see 100% unless you have very simple, fixed student
timetables. Also, remember that when you manually schedule a class into a
student timetable to replace a class that would not fit, that student might be
fully scheduled, but he or she still has an unfilled request. As a result, after
you have manually edited student timetables, your students will be more
scheduled than suggested by the figure in the Percent column.

Viewing Unscheduled Students

The Req Sch Rqd column in the Students Main window reports the number
of credits scheduled for each student.

Use Scheduled < Required and Scheduled < Requested from the Lists menu
to examine students who aren’t fully scheduled.

If you are using Fragmented (term-based) Course Requests, these columns
reflect the requested terms.

Use Timetable Problems from the Lists menu to find scheduled students
who lack prerequisites, co-requisites, or gender requirements.

Generating Scheduler Reports

You can generate reports to show the schedule and scheduling status of
your school. The Reports menu lists these reports under 4 columns.
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Report

Menu
Column

Description

Class Rosters

Lists

Lists all the students enrolled in a class,
for term(s) selected in Print terms of the
Print Options dialog. Class Roster from
the Lists menu in the Main window
creates a Student Subset.

Teacher Rosters

Lists

Produces the Class Rosters Report of
classes for selected teacher. Each class is
printed on a separate page, by teacher.
Select Print Blocks in the Print Options
dialog to print all blocks and their
scheduled teachers, rooms, and number
of enrolled students.

Free Students

Lists

Lists free students by block.

Block
Capacities

Lists

If the Seats Filled column reaches 100%,
and some students are still unscheduled
in that block, schedule another class in
that block.

Check Requests

Special

Checks student requests, listing filled
and unfilled primary and alternate
requests, with reasons for unfilled. If the
class could be scheduled but is not,
Scheduled column shows N.

Student
Locations

Special

Prints an alphabetical list of selected
students and the rooms they are
scheduled into in each block.

Ethnic Mix

Special

Produces gender and ethnic category
statistics for selected students. Select all
students in a class roster to generate
statistics for that class.

Check
Timetables

Special

Checks timetables for selected students,
listing students, with class names, who
lack prerequisite, co-requisite, or gender
requirements.

Student

Timetable

Prints selected students’ timetables in
various formats, according to selected
Print Options.
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Step 6: Starting the School Year

At the beginning of the school year, perform the following procedures.

Printing Timetables and Class Rosters

Print teacher and student timetables, and class rosters. Continue to print
these reports as students enroll or change timetables.

Before printing, set up your preferences and print options.

To set up preferences and print options:

1 From the Edit menu, choose Preferences, then set up the following
information:

e If you used Resource Mapping (cloned rooms and/or teachers, and
linked courses), select “Use Resource Mapping.”

e If you have scheduled students into classes taught at other schools,
select “Show All District Items.”

e To show when classes actually meet, or if you used period
scrambling, select “Show Actual Periods.”

& Preferences - Scheduler !Em
File Edit

Freferences

™ Use Resource Mapping
¥ Show Imactive Students
™ Shew Grade M2 Students
IV Show A1l District ltems

Transfer Date 07 MAR 99
Course Name Format [l arne Grade

—When Pasting Clagzes
¢ Don't paste if class conflicts

" Remove PERIODS that conflict with paste
" Remove CLASSES that conflict with paste

— Period Scrambling Display
% Show Actual Perinds

€ Show Scrambled Periods

2 If you store printed reports in a binder, set the left margin to at least 1
inch. From the System menu in the Shell, choose Margin Setup.
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To print student or teacher timetables, or class rosters:

1  Select students or teachers in the Students, Teachers, or Classes Main
window.

2 From the Reports menu choose a report.
3 In the Print Options dialog:
e select the items you want printed

e select the Timetable days and Print terms to include in the
timetable

e if you want to print a message on student timetables, type it in the
Report Message text box

4 Click OK.

Recording Transfers

If you use Transfer Recording in School Setup to keep timetable and class
roster history, Scheduler keeps track of which classes students are in on
specific dates.

This information is called Historical student timetables and Historical class
rosters. Attendance uses this information to show, for example, that a
student’s Period 3 attendance was for Sewing in September, even though
she later transferred into Metalwork.

If your school allows class transfers during the first weeks of the school
year, you might prefer to turn off Transfer Recording until the schedule is
stable.

See Transfer Recording in the School Setup Guide for more information.

To record student transfers:

e In School Setup, choose Transfer Recording from the School menu.
Then select options.

To edit or delete transfers:

e  Use the Student Timetable window in Scheduler. See “Student
Timetable” on page 106.

Step 7: Changing Information During the Year
When the school year is underway, you can edit student timetables, enroll
new students, and make minor changes to the school timetable.

When editing information after school starts, be aware of the Transfer Date,
as described in the following procedures.

For each teacher whose class roster changed, the Today’s Add/Drop report
from the Reports/Lists menu shows the students added or removed.
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Editing the School Timetable after School Starts

When you have scheduled students into a class, you must use these
procedures to reschedule or edit your school timetable. Otherwise, students
will lose the class held in the period you edited, even if you reschedule the
class into the same period or another period.

Before rescheduling a class in the school timetable:
1 From the Edit menu, choose Preferences.

2 Set the Transfer Date to the last day students take the class in its current
timeslot. If the class is in a term that has not begun, use the current
date. Close and save Preferences.

3 In the Classes Main window, select a class. Then create a Student
Subset containing the class roster by right-double-clicking the class.

4 Select all students in the subset, then from the Schedule menu, choose
Clear.

5 Inthe Clear dialog, select “Clear selected classes from student
timetables,” select the terms to be cleared. Click Clear.

6 Reschedule the class by choosing School Timetable from the Windows
menu and removing the class. Any students in the class will also be
removed from it.

7  Schedule the class. See “Manually Scheduling Classes” on page 40.

8 Reschedule students into the class by highlighting the rescheduled class
and choosing Copy from the Edit menu. Then select all the students in
the Student Subset and choose Multi-Paste from the Edit menu. All
students free at the new time the class is taught will be scheduled into
the class.

If you remove any block of a class from the schedule, or change its teaching
time, all students scheduled in that class are removed from that block.
These students will miss 1 block of the class, but as long as they are
enrolled in any block of the class, Scheduler assumes that their request for
the class is filled.

Editing Student Timetables after School Starts

The most flexible way to change student timetables is to use the Student
Timetable window. When using this window, click “View Transfers” to
print a Transfers Report before and after making changes. The report
verifies the changes.

If you use Transfer Recording in School Setup to track timetable and class
roster history, Scheduler records the dates students are in each class.
Attendance can then determine class attendance from period attendance.
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Selecting a Transfer Date

When you change a student timetable, the student’s first day with the new
timetable can be your choice of:

e The Start Date for Change, if you make the change from the Student
Timetable window.

e The Transfer Date, if you use any other methods of changing student
timetables, such as Paste and Multi-Paste.
To change the transfer date:

e In the Student Timetable window, click “Start Date for Change” and
edit the date.

When changing a student timetable in the Student Timetable window,
always start with the oldest change, and ensure the timetable is correct
from then to the current date. When you change a timetable, the change
affects that period from the Start Date for Change to the end of the year
or term. It overwrites any later transfers for that period.

e From any other window, choose Preferences from the Edit menu and
edit the Transfer Date.

Example of Student Transfer Dates:

In Block A, Chris can take either Geography, Sewing, or Math.
e Chris started the year in Geography.

e On September 30, he transferred to Sewing.

e On October 30, he transferred to Math.

In December, you notice that you had mistakenly transferred Chris into
Sewing on October 2 instead of September 30. You can correct that date,
setting it to September 30. However, you must remember to put Chris back
in Math as of October 30.

To find and highlight a class in the class pool, control-click the class name
in the lower half of the window.

Changing a Teacher or Room after School Starts

To change a teacher or a room:

1 To add a new teacher or room, in Details, choose New from the File
menu. Enter the new teacher or room information.

2 Open Scheduler in Master mode.

3 From the Windows menu, choose School Timetable. In the Enter by
section, select the term or other timeframe.

4 In the Class Name list, highlight the class for the new teacher.
5 In the Class Timetable list, highlight the class to be scheduled.
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6 In the Teacher Name list, double-click the name of the new teacher.
OR
In the Room Name list, double-click the new room.

7  If the original teacher will not be active for the rest of the year, return
to Details. Change “Active” in the Personal tab to No, and enter the
date the teacher becomes inactive.

Scheduling New Students after School Starts

To schedule a new student after the school year has started:

1  In the Students view, double-click the name of the new student to
display the Student Timetable window.

2 Click “Start Date for Change” and set the date to the new student’s first

day of school.
'==- de ptable (A al Period Scheduler&g |=uf _ | 1] %
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3 Enter a timetable for the student. See “Manually Scheduling 1 Student”
on page 55.

OR
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Enter requests for that student, then select the student in the Student
Main view. From the Schedule menu, choose Assign Students.

Transferring Student Marks to Another Class

You can transfer a student’s marks from 1 class to another. When a student
transfers out of a class in 1 term and into another section of the class in the
next term, schedule the student into the new class, then use Transfer Marks
to move the marks.

To transfer a student’s marks:

1 Use the procedure, “Editing Student Timetables after School Starts” on
page 67 to add a new class to the student timetable.

2 After the new class has been scheduled, in the Student Timetable
dialog, click “Transfer Marks.”

3 Select “Show all active classes” at the bottom of the Transfer Marks
dialog.

The left column displays Source Classes in which the student is
currently enrolled and/or has marks. This should include the newly-
scheduled class.

The center column displays the Status of each class for that student.
The right column, Destination Classes, is initially empty.

4 From the Destination Classes popup, select the class to receive the
transferred marks from the Source Class. You can select a Destination
Class only once.

5 If you want to replace existing bin marks, select “Overwrite bins with
existing marks,” then click OK.

6  Check the Report Card bins to ensure all marks have been transferred.

Printing Today’s Add/Drop Report

For each teacher whose class roster changed on the current transfer date,
Today’s Add/Drop report lists the students who were added to or removed
from each class the teacher teaches.

To print the Today’s Add/Drop report:

1 From the Edit menu, choose Preferences and enter the Transfer Date
for which you want to print the report. Close Preferences and click Yes
to save your changes.

2 From the Reports/Lists menu, choose Today’s Add/Drop.

Generate a Student Subset containing the students who entered or left a
class on the currently selected transfer date by choosing Changed from the
Lists menu.
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Scheduling Fragmented Course Requests

Overview

Fragmented course requests allow students to request 1 or more terms of a
course. If a student cannot take all the terms of a course in 1 year, the
student can request specific terms of the course.

Use Fragmented Course Requests when a student requests 1 or more terms
of a course out of the order in which it is offered.

For example, if a student’s schedule can accommodate Algebra 10 in the
first term but not the second term, Fragmented Course Requests allows the
student to request term 2 of Algebra 10 in another year.

Fragmented Course Requests is useful for courses not offered every year or
every term. If parts of a course are taught in different years, schedule
students into one part of the course this year, and the next part of the course
in another year.

Use Fragmented Course Requests in the following situations:

e A student needs to repeat only some terms of a course, not the entire
course.

e A student cannot take all terms of a course consecutively due to
scheduling conflicts.

e Different terms of a course are offered in different years.

If you use Fragmented Course Requests, you must remove duplicate
requests before assigning students and entering fragmented requests.

Preparing to Assign Fragmented Course Requests

To set up for fragmented course requests:

1 Assign requested courses as you normally would. See “Step 1: Entering
Student Requests” on page 16.

2 If necessary, remove duplicate requests. See “Removing Duplicate
Requests” on page 20.

Assigning Term-Based Student Requests

When you have assigned requested courses and removed duplicates, you
can assign terms to student requests.
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To enter terms for student requests:

1 In the Students Main window, right-double-click on a student, or
highlight a student and choose Student Requests from the Windows
menu.

2 In the lower list, click the Linked Alternates VCR button, and choose
Terms.

Initially, all terms for that student’s course requests are highlighted.
Terms not defined in School Setup are dimmed.

3 Toremove a request for a term, click on the term number to deselect it.
Use F3 and F4 to move back and forth between students.

4 In the top right of the Student Requests window, select Requests using
the VCR buttons to show the total number of requests, including
fragmented requests.

For example, if there are 10 requests for the full year and 2 requests for
part of the year, that column shows 12.

Setting Sections for Fragmented Requests

Assigning Students

Using Students View

You should check the number of sections per term to make sure it is
correct. When scheduling a different number of requests for different terms,
Scheduler might create more sections than is needed. Change the number of
sections in terms that have too many or too few sections. See “Editing
Section Information” on page 27.

In the Sections window, use the VCR buttons in the top right area to choose
either “Sections Set Per Term” or “Course Request Totals Per Term.”

Course Request Totals Per Term is the number of students requesting that
course for that term. Use this total to determine how many sections are
needed for each course.

Use Assign Students from the Schedule menu as you normally would.
Students are assigned according to their term-based course requests.

The Req, Sch, and Rqd columns are based on requested terms. For example,
if a student requested 2 terms of a 2 term course, but can only be scheduled
into 1 term, the Sch column shows half the credit for that request.
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Using Courses View

In the Courses view, you can use the VCR buttons in the third column to
select Requests Per Term. This column is divided into terms to show how
many students have requested a course in each term.

Using Student Timetable

Use the Student Timetable window to check and modify a student’s
timetable for each term.

Viewing the Terms Requested Column
In the third column in the top list, use the VCR buttons to view Terms
Requested, which shows the terms the student has requested the course.

If the student has a request for the class, this column shows the terms
requested. If none of the terms are selected, the student has not requested
the course.

If a student requested a class but did not request any terms for that class,
this column shows “No Terms Selected.”

Reading the Status Column

The left side of the Status column shows any problems with scheduling
term-based course requests.

Partial The student is not scheduled into all requested terms. For
example, a student requests all terms of a course but is not
scheduled into all terms; or if a student requests 3 terms of a
4 term course and is scheduled into fewer than 3 terms. In
both cases, the Status is Partial.

Problem The student is scheduled into a term that is not a requested
term.

Requests None of the requested terms match the terms the class is
taught.

Taking The student’s requests are scheduled.

Checking for Scheduling Conflicts

An easy way to check for scheduling conflicts is to display Terms
Requested in the third column and Terms Taught in the fourth column, then
check the Status column for problems.

In the Enter by section at the top of the Student Timetable window, select
Term to schedule students by term. Select Year to schedule students into all
the requested terms.
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Generating Reports about Fragmented Course Requests

The following reports show the terms of fragmented course requests:
e Student Requests

e Course Request Tally

e Wait Lists

e C(Class Rosters

e Brief Requests

e Check Requests

For more information on reports, see ‘“Printing Reports” on page 96.
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Generating the Term-Based Conflict Matrix Report

The Term-based Conflict Matrix Report is only for viewing conflicts in
selected terms. To make changes to the schedule, use the Conflict Matrix
window from the Windows menu.

To generate a term-based conflict matrix report for selected terms:

1 From the Reports/Special menu, choose Term-based Conflict Matrix.
The Select Terms dialog appears.

2 Select terms and click OK.

The title bar of the Conflict Matrix Report shows the terms of this
report.

3 To print this report, choose Print from the System menu.
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Using Windows and Functions

Overview
In this section, Scheduler windows and functions are described in
alphabetical order.

If fields for a window are described, they are in order from top to bottom,
left to right, as they appear in the window.

Assign Aides

Assign Aides is only available when Scheduler is in Master Mode.

You can assign aides any time after scheduling all classes that need
teaching aides. Do not enter course or room preferences unless the aide is
also a teacher and teaches courses.

To assign aides:
1 In Course Details, Scheduler tab, select the Aide Type.
2 In Teacher Details, select Scheduler tab.

3 In “Scheduling Teacher Type,” select Teaching Aide for each staff
member acting as a teacher aide, then select an Aide Type.

4 In Scheduler, build your school timetable as usual.

5 In the Courses Main window, select all courses. Then from the
Schedule menu, choose Assign Aides and select options.

6 Click Load. To view or manually edit teaching aides, use School
Timetable from the Windows menu.

Assigh Homerooms

Assign homerooms after the school timetable is complete and students are
scheduled.

For a room to be a homeroom, in School Setup, Rooms menu, choose Room
Setup, then select Yes in “Use as HRoom.”

Select homeroom numbers or assign selected students to a homeroom based
on a timeslot and/or a class.

Homeroom numbers assigned with Assign Homerooms are independent of
scheduled homeroom courses. These homeroom numbers can help to
schedule students into a homeroom class.
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If you re-assign homerooms for a new term, and Transfer Recording is
turned on, the new homeroom assignment appears the next day.

Assigning Homerooms by Selected Class and Homeroom

You can assign homerooms to selected students taking the classes you
specify. You can place students either into homerooms you specify, or use
Win School to automatically schedule the homerooms. Later, override those
assignments for selected classes.

To assign homerooms by selected class and homeroom:

1 Select students, then from the Schedule menu, choose Assign
Homerooms.

2 Select the third option: “Homerooms assigned by the selected class and

homeroom.”
¥ Homerooms assighed by the selected class and homeroom.
Class Hame Hoom Homeroom Humber

v. Spanish (1] - -
Algebra 11 [2) Mt — 100 Clagzroom —
Biology 17 [1] MAA 1m Clazgroom
Dratting 12 1] M2, 102 Clazzraam
English 11 [1) it —— 103 Clagzroom
Englizh 17 [2] M AR 104 Clazgroom _—
Englizh Lang. 12 1] MAA 105 Clazzroom
Englizh Lit 12 [1) Mt 106 Clagzroom
French 11 (1] M AR a7 Clazgroom
French 12 (1] MAA 108 Clazzroom
Geography 12 1] M % 109 Clagzroom 7

3 Highlight a class to the left, and on the right, right-double-click a
homeroom number.

4 Repeat as necessary.

Use the “Homerooms assigned to the class that selected students are taking
in the following term, day, and period” option carefully when processing
more than 1 class at a time. Assign Homerooms works through the Class
Pool alphabetically, placing students as specified. Students in the class
roster of more than 1 of these classes end up in the homeroom associated
with the last class they are taking that is processed.

To use this option, select all students so that entire class rosters are assigned
to homerooms.

When you assign a homeroom associated with a specific class, the selected
students are first put into a subset student list, then assigned a homeroom
based on the specified class. If a student does not have a class at the
specified time, the student name will stay in the subset list.

If all students have a class in the specified time, the subset list is empty
when Scheduler completes assigning homerooms.
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Assign Students from the Schedule menu contains all the options used to
assign students to classes.

See “Assigning Students” on page 59 for details on how to assign students.
This section describes some options in the Assign Students dialog.

T |

Class Owarfiling 0 %

b &irnum time per student [zec, eg: 0] IE!D—

¥ Use Backhracking

[~ Use selected courses only

¥ Use alternates

[ &low partially scheduled classes

[~ Maimum of one course per department per tarm

¥ Schedule students into clusters

[™ Choose zections accarding to Linked Groups and Following Triplets

[~ Enforce prerequisite rules

Periods

Terms

BB [ [ [ [ [ [T T[] corcef [ox]

Allow Partially Scheduled Classes

Normally, Assign Students does not place students in classes that are not
fully scheduled. This option overrides that restriction.

Assign Students considers a class fully scheduled if all the meeting times
for the class have been scheduled in the correct number of terms. If Teacher
Required and Room Required are selected for that course in Details, then
all of those classes must have teachers and rooms.

Use this option if the room or teacher is left unassigned because it is still
undetermined, or if 1 or more terms won’t be scheduled until a later date.

Choose Sections According to Linked Groups and Following Triplets

If this option is selected, Assign Students places students in consecutive
sections of classes in Following Triplets, and in the same sections of Linked
Groups taught in the same period but on different days or terms.
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If this option is not selected, students are scheduled in any section of the
courses they request. For example, they might not be scheduled into
consecutive sections of a Following Triplets.

Select this option if you want students placed in sections according to
Linked Group and Following Triplets patterns.

Deselect it to schedule students into Linked Group courses that are taught
simultaneously. In this case, the student can’t be in 2 places at once and
must take sections that do not follow the Linked Group pattern.

Enforce Prerequisite Rules

Enforce prerequisite rules does not check student historical data for
prerequisites, only the courses actually being requested by each student are
considered.

Use this option if you have set prerequisite requirements for courses in
Details, and you want Scheduler to check those requirements against a
student’s requests before assigning them.

This is useful when students complete a course in 1 semester.

Maximum of One Course Per Department Per Term

This option forces Assign Students to place students in a maximum of 1
course from a department in each term.

For schools that want to balance the content of student curriculum, this
option checks that students don’t get all their art courses in 1 term, and all
their science courses in another. You can remove this restriction later to try
to fill remaining unfilled requests.

To be successful with this option, check that your school timetable will
accommodate the restriction.

Your school must have a fairly large number of departments: at least 1
department for each course that a student normally takes in a term.

You can run Assign Students initially with this option selected, which
should distribute most courses across the terms. Then, either manually
schedule the remaining classes or run Assign Students a second time with
this option deselected.

Schedule Students into Clusters

Selects sections of courses for students to take according to Clusters &
Teams settings.

When you select this option, we recommend you also select “Use
Backtracking” and deselect “Use alternates.” To schedule student alternate
requests, run Assign Students once with this option selected to place your
students in clustered classes. Run it again with “Schedule students into
clusters” and “Use Backtracking” deselected, and “Use alternates” selected.

Using Windows and Functions e Assign Students 79



Use Alternates

Use Backtracking

Win School Scheduler

If you have created clusters in the Clusters & Teams dialog, select this
option before running Assign Students.

If all primary requests could not be filled, Assign Students tries to schedule
alternate requests.

If “Use selected courses only” is selected, Assign Students will not fill
Global Alternate requests.

If you have entered alternate requests, select this option. Some schools
prefer to schedule students into as many classes as possible without
considering alternates, then run Assign Students again using alternates.

Assign Students experiments with the different possible schedules allowed
by multi-section courses to find the schedule that fills the most requests.
Therefore, the more class options students have, the more timetable
configurations are possible.

Increase the backtracking time spent on analyzing each student to provide
the best possible scheduling.

Because this option slows the Assign Students process, deselect it when
you are testing your school timetable.

When you are satisfied your school timetable is satisfactory, clear
timetables with Change Students from the Schedule menu. Then select all
students and run Assign Students with Use Backtracking. Assign Students
uses every means at its disposal to schedule students into their first-choice
required and elective classes.

Use Selected Courses Only

Assign Students fills requests only for courses selected in the Courses Main
window. Neither linked nor global alternate requests are filled.

This option is useful for scheduling students into single- or double-section
courses.

Use it early in your scheduling process to give high priority to certain
course requests. Otherwise, Assign Students gives priority to required
courses over electives.

If you have cleared students from some courses, select this option and those
courses to assign students to only those courses, and to reschedule them in
the school timetable.
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Change Students

Select students in the Students Main window, and choose Change Students
from the Schedule menu. You can change the selected students’ timetables,
including creating or deleting requests.

Create Requests from Timetables

Use this option to give students requests for the classes they are currently
taking. This option is designed for schools that created their school
timetables manually without entering student requests, and want to
experiment with using Create Timetable and Assign Students to build
timetables.

Use this option after your student timetables have been created, and after
you have made a copy of your existing data files. Schools that need an
accurate conflict matrix to generate an exam schedule can use this function
at the end of a term or semester.

To create requests from timetables:

1 Make a copy of your existing data sub-folder. The path to your existing
data sub-folder is shown in Win School Shell, after “Data Path =.”

2 In your WINSCHL.INI file, change the DATA= line to point to the
new sub-folder.

For the change to take effect, quit and re-start Win School.
4 In the Students Main window, select students.

5 From the Schedule menu, choose Change Students, and select Create
Requests from Timetables, then click Perform.

Change Students m

Far the selected student(s)...
[ Clear Requests

[ Clear Altemates

[ Clear Timetables

= Cleansddiional Elasses

[ izsign Fequests

[v iCreate Requests from Timetables

[ &dd Co-requisites

[ Remove Duplicate Requests

[Selected proceszes will be done in the order in
which they appear, one student at a time)

Perform I Cancel |
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That completes the first step of scheduling: Entering Requests. You can
now build timetables.

6  When you have finished experimenting, change the DATA= statement
in your WINSCHL.INI file to point back to your real data sub-folder.
Note that you will have to quit Win School and start it again for the
change to take effect.

Clear, from the Schedule menu, is only available when you started
Scheduler in Master mode.

The Clear command can:

e Remove classes or courses from student timetables.

e Remove classes or courses from the school timetable.

e Clear course requests from student request lists.

e Replace cleared course requests with their linked alternates.

e Remove reservation labels from selected room or teacher timetables.

If you clear classes or courses from a student’s timetable, the student’s
requests remain unchanged. If you don’t want that student in a class, you
must also clear the student request.

If you have changed the school timetable, you might want to remove
specific multi-section courses, so Assign Students can re-consider sections
to place students. Or use Change Students to clear all classes from selected
student timetables.

Clear course requests from student request lists when you have finished
scheduling and are certain that the requests can’t be filled. Or use Change
Students to clear all selected student requests.

Clear reservation labels from rooms and teachers when other commitments
no longer prevent them from being scheduled for classes.

To remove requests for a course:

1  Select courses in the Courses Main window, then from the Schedule
menu, choose Clear.

2 Select “Clear selected courses from student requests lists.”

3 If you want a linked alternate request to become a primary request,
select “Replace first-choice request with its linked alternate.”

If you don’t select this option, the linked alternate is deleted along with
the first-choice request.

4  Click Clear.
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To remove classes from student timetables:

1 Select classes in the Classes Main window, then from the Schedule
menu, choose Clear.

2 Select “Clear selected classes from student timetables,” and highlight
terms in the Clear Terms section.

Classes scheduled in selected terms are removed from student
timetables. Classes that are not taught in highlighted terms are ignored.

3  Click Clear.

To remove classes or courses from timetables:
1  Select courses or classes, then from the Schedule menu, choose Clear.

2 Select “Clear selected courses from school and student timetables” or
“Clear selected classes from school and student timetables.”

3 To clear locked classes, select “Modify Locked Classes.”
4  Highlight terms in the Clear Terms section.

Classes or courses scheduled in selected terms are removed from
student timetables. Classes or courses not taught in highlighted terms
are ignored.

5 Click Clear.

To clear reservation labels:
1  Select rooms or teachers, then from the Schedule menu, choose Clear.

2 Select “Clear reservation labels from selected rooms’ timetables” or
“Clear reservation labels from selected teachers’ timetables.”

3 To clear all labels except the built-in Reserved label, select “All labels
but ‘Reserved’.” Deselect to clear all labels.

4 Highlight terms in the Clear Terms section.
5 Click Clear.

Create Timetable

Create Timetable is only available in Scheduler Master mode.

This command schedules unlocked classes into the school timetable
according to constraints set in Course and Teacher Details. You use Create
Timetable more than once to complete the school timetable.

Using Windows and Functions e Create Timetable 83



Win School Scheduler

Create Timetable m

[+ Lookahead — Select teacher for class

[ Scheduls only selected courses € From Course Preferences

. " From Load Teach
[ Keep teachers in homerooms 1O L0ac | EaEhsrs

[¥ lgnare rooms and teachers
— Start zcheduling with:

Allowable Potential-Conflicts [ = Special Courses

& Nomal Courses

Pre-Check |
—when problenm ocours:
Schedule
" Stop
Optimize I * Pause
| " Continue

Cancel

Use Pre-Check before performing an actual scheduling run to discover
conflicts in room and teacher selections.

When you click Schedule, classes are scheduled according to their
difficulty. Special Courses are scheduled first, unless Normal Courses or
Optimize is selected. The rest of the courses are scheduled according to
difficulty, from the first sections of all courses, to the second sections of all
courses, and so on.

Click Optimize to try to make improvements to the timetable.
Use Create Timetable after you have:

e Entered all student requests.

e Set sections.

e Loaded teachers (optional).

e Manually entered and locked any classes that have to be taught by a
particular teacher at a specific time in a specific room.

Data Transfer

Data Transfer is only available in Scheduler Master mode.

Use Data Transfer from the File menu to import or export student
timetables in the file formats described below, and class timetables by block
or by period. Use Data Transfer to transfer school and/or student timetables
between Win School and other automated systems, including Mac School
and district mainframe computers.

Import class timetables before using Create Timetable, then use Lock
Classes from the Schedule menu to prevent Create Timetable from making
any changes to the imported timetable information.
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Import student timetables before using Assign Students.

Student timetables can be exported in user-defined formats using ASCII
Transfer.

The following sections describe using Data Transfer to import or export
data in detail.

Exporting Scheduler Data

When exporting Class Timetables by Period, the Term numbers are
included in the repeating group for each period. The starting period and
finishing period are always the same.

To export Scheduler data:

1

2
3
4

Importing Scheduler Data

Select a few students or classes to be exported.
From the File menu, choose Data Transfer.
Select the type of data to be transferred.

If this transfer is a test, select Trial Transfer, then click Export.

Dota Tranctor |

& iClazs Timetables by Period
™ Claze Timetablas by Block
i Studert Claszes

Iv Trial Transfer

Cancel I Impart Export

Check the Export Error Report window to make sure the data exported
correctly.

If the data exported correctly, select all the students or classes to be
exported.

Repeat Steps 2 and 3.
Provide a name and destination for the export file, then click OK.

The Export Error Report window lists any errors encountered in the
process, or verifies that your data was exported correctly. If there are
no errors, the data transfer is complete, and you can close the report
window.

Before importing any data, make a backup copy of your existing data.

When you import student timetables, no class that is already in a student’s
timetable is removed during the import. If any block of an imported student
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timetable conflicts with a class that is already in that student’s timetable,
that block is not imported. All, some, or none of a class can be imported.

Classes that could not be completely imported into a student’s schedule are
listed in the Import Error Report.

When you import class timetables, if there is a conflict in 1 or more blocks
between a class being imported and an existing class, those blocks will not
be scheduled, and the class is included in the Import Error Report. If 1 or
more blocks of the imported class can be scheduled, they will be.

You cannot import classes with teacher or room clones, nor import into
classes with teacher or room clones. You should manually assign the cloned
teachers and rooms after the import.

To prepare to import Scheduler data:

1
2

Make a backup copy of your data.

Put the source file on your PC or on a network your PC can access.
Transfer is slower over a network.

Make sure that all the school IDs and terms for imported data have
been set up correctly in School Setup.

Create all course numbers for imported data in Details.

If you are importing student timetables, create student numbers in
Details.

Create classes with section numbers in the Scheduler Set Sections
window, or import them with the new file.

If you are importing class timetables, create their room numbers, days,
periods, and blocks in School Setup.

Create Teacher numbers in Details.

If any class being imported has a section number that does not appear
in the Set Sections window, that section number is added automatically.

If a class being imported has a section number that appears in the Set
Sections window, the existing schedule for that class is changed to the
imported data.

To import data:

1

Run Scheduler in Master mode. From the File menu, choose Data
Transfer, and set options.

Select Trial Transfer.
Click Import.
Specify the name and location of the file you want to import.

An Import Error Report lists any errors encountered during the process,
or verifies that your data has been imported correctly.

If the Import Error Report shows no errors, close it and repeat the
process with the Trail Transfer checkbox deselected.
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6 When the import is finished, the Import Error Report window shows

the result. If there are no errors, it will display Data Transfer Complete,

and your schedule is assembled.

7 Inspect the imported data. If your timetables do not appear accurate,

restore your data from the backup and do another trial import to

identify the source of the problem.

Understanding File Format

When exporting files, the files are exported in a specific file format. When

importing, the data file must follow the format to be imported properly.

Fields are surrounded by quotation marks and separated by commas.

Records are separated by carriage returns.

Do a trial export to see what the exported file looks like.

Each record contains the fields shown in the following figure:

Student Classes

Student number

School number of student

Course number
Section number
Term numbers

School number of class

Repeat
for each
class.

Class Timetables by Period

Class Timetables by Block

Course number
Section number

Term Number
Day

Starting period
Finishing period
Teacher number
Room number

School number of class

Repeat for
each period,
for the days
in which
class is
scheduled.

School number of class

Course number
Section number

Block-Term
Teacher number
Room number

Repeat
for each
Block-Term.

For student classes, term numbers are linked in series. A class taught in

Terms 1 through 12 will have 123456789ABC in its Terms field.

For class timetables by period or by block, the term or block-term numbers
are repeated as indicated by the table above.

Using Windows and Functions e Data Transfer

87



Win School Scheduler

Days are indicated by letters:

Abbreviation Fixed Day Relative Day
M Monday, week 1 Day 1
T Tuesday, week 1 Day 2
w Wednesday, week 1 Day 3
R Thursday, week 1 Day 4
F Friday, week 1 Day 5
S Saturday, week 1 Day 6
U Sunday, week 1 Day 7
m Monday, week 2 Day 8
t Tuesday, week 2 Day 9
w Wednesday, week 2 Day 10
r Thursday, week 2 Day 11
f Friday, week 2 Day 12
S Saturday, week 2 Day 13
u Sunday, week 2 Day 14

A 5-day fixed timetable uses M, T, W, R, and F. A 6-day relative timetable
uses M, T, W, R, F, and S, even though it meets Mondays through Fridays
only. A 2-week fixed timetable that does not meet on weekends uses M, T,
W,.R,F,m, t, w, r, and f.

When importing class timetables by period into Win School, you can link
days when class timetable elements are repeated. A day field of MWF
indicates that on Mondays, Wednesdays, and Fridays, the class is taught
with the following time, room, and teacher.

Periods are indicated by numbers. The starting period and finishing period
are always the same.

Preferences — Scheduler

From the Edit menu, choose Preferences. You can set Scheduler
preferences as well as preferences for Win School : System and
Win School : User.

If the window title bar does not show Preferences - Scheduler, choose
Scheduler from the Edit menu.
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7. Preferences - Scheduler !Em
File  Edit

Freferences |

[ Use Resource Mapping
¥ Show Inactive Students
[ Show Grade NA8 Students
¥ Show Al District [bers

Tranzfer Date 10 MAR 93
Courze Name Format P Mame Grade

—%When Pazting Claszes
& Don't paste if class conflicts

" Remove PERIODS that conflict with paste
" Remove CLASSES that conflict with paste

— Penod Scrambling Dizplay
% Show Actual Periods

™ Show Scrambled Periods

Use Resource Mapping: Scheduler replaces cloned teacher and room names
with the original names, as defined in Details with Clone Teacher from the
File menu, and in School Setup with Room Clone from the Rooms menu.

This option affects all room and teacher names displayed in Scheduler.
Select it after all timetables are built and before printing them. Do not select
this option while building timetables, as confusion may result from having
the same teacher or room appear in a list more than once.

Show Inactive Students: show inactive students in Scheduler windows and
reports. Select for currently inactive students when scheduling. Students are
inactive if their enrollment date has not yet arrived or if they have
withdrawn or left. Active status is defined in the Codes tab in Student
Details.

Show Grade N/A Students: show Grade N/A students in Scheduler
windows and reports. Grade levels are assigned to students in the Details
Personal or Enrollment tab.

Show All District Items: controls the display of data for other schools. Use
this option if your students attend classes at other schools and you wish to
include this information in your timetables. Select this option to display:

e Teachers assigned to other schools in Details.

e Rooms assigned to other schools in School Setup.
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e Courses that have their District Use Only fields set to Yes in the
Scheduler tab in Details.

Transfer Date: before changing a student timetable, set the Transfer Date to
the first day the student needs the changed timetable. The Transfer Date
applies to all methods of changing student timetables except the Student
Timetable window. Changes in the Student Timetable window take effect
on the Start Date for Change instead of the Transfer Date. The Start Date
for Change can be any date. When you change a student timetable using
most methods, such as Multi-Paste, the Transfer Date cannot be earlier than
the Transfer Date of the most recent timetable change for the student or
class.

Remove PERIODS that conflict with paste and Remove CLASSES that
conflict with paste: any classes conflicting with the class being pasted are
unscheduled according to your selection. Use these features carefully, as
you may find periods or classes removed unexpectedly.

Period Scrambling: determines the block arrangement that Scheduler
displays and prints. When building the school timetable, select Show
Scrambled Periods to display and print the block structure that appears only
in Scheduler. Select Show Actual Periods before printing timetables for
distribution to students and staff.

Room Timetables from the Windows menu lists rooms and timetable
blocks, displaying scheduled classes, class names, section numbers, teacher
names, and number of students. If no class is scheduled in a room for a
particular block, “Free” or the assigned reservation label is displayed.

Print individual room timetables by selecting them in Rooms view and
choosing Print from the System menu.

Use View Options from the System menu to display Room Timetable
information by block, by term or by period for selected timetable days only.
The View Options setting also affects room timetables you print from this
window.

School Timetable from the Windows menu provides a window for
manually scheduling classes, and for reserving teachers and rooms for
specific classes and times. You can edit your school timetable in this
window.

Select options in the top part of the window to control the display in the
lower part of the School Timetable window.

Use the 3 scrollable lists in the middle part of the window to find specific
class, teacher, or room information.
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HE oo etable {Actual Period
Timetable for: Timetable Term:
Block | Period | Tem ‘ear Classes | Foom | Teachers 23 B I I (I [

Use the bottom section of the window to view and edit class, room, and
teacher timetable information. Until a class is fully scheduled in all terms
selected in the Sections window, its name is colored in the Class Name
column. When a class is fully scheduled for the year, its name is black.

Scheduler®g |=o| _ || %

Sched Class Teacher:
Vear Main | Second | Aide

Class Display Mode:

Floom/Teacher Blocks Superimpose | Superimp. Al Difficulties
Lock I |
Reserve Label I Teacher Mame Pref Room Number Room Capacity
d [« | o, I —~
| 1 —
Mot Scheduled N2, 1] N/& 1]
- - | 0] I
Prep Cavein, Tich A, 1] 100a Classroomn 15 I
Counzeling Dean, Bob a 100b Clazzioom 15
Study Hall Doctor, Heinrich 1] 101 Classoom 35
Spare Diomoney, Dennis a 101a Claszioom 35
Dept head mtg. Duchesne, Yanick i} 102 Classroom 35
Harrisan. John Patrick, 1] 103 Claszioom 35
Mann, Peter Joseph 0 104 Classoom 35
W Marcos, Imelda - 1] 105 Claszioom 35 4
Room Timetable
Period Day 1 Day 2 Day 3 Day 4 Day 5
: 2|
1 Algebra 11 (1] Algebra 17 (1] Algebia 17 (1] Calculuz 12 (1)
2 Algebra 12 (1] History 11 (2]
3 Algebra 11 (1] Calculuz 12 (1]
4 Study Hall Algebra 12 (1] Study Hall Study Hall
5 Calculuz 12 [1] Hiztory 17 (2]
E History 11 (2] Calculus 12 1] Algebia 12 (1]
7 History 11 (2] Algebia 12 1] Algebia 11 (1]
8 Caleulus 12 (1) Algebra 12 (1] Histary 11 [2]

Using School Timetable Options

The options in the top third of the School Timetable window are in 5
sections.

Enter by

Use the Enter by options to select the editing mode for the schedule. For
simple timetables, Year is usually selected.

Block: any timetable changes made to a block affect only the block in
which you make them. This is the only mode in which to schedule classes
into blocks that aren’t assigned anywhere in the Timetable Structure in
School Setup.

If blocks appear more than once in your Timetable Structure dialog in
School Setup, and in different periods, the class will be scheduled into that
block everywhere it appears regardless of the period. If you are working in
Term or Year mode and the class has to be scheduled into more than 1
block, Scheduler picks blocks that first appear in the timetable in the same
period, but on different days.

Period: for timetables that contain repeated block letters in different
periods, this mode is easiest to use. Changes to a period affect only the
block you edit. If the block appears only once in the timetable, only that

Using Windows and Functions e School Timetable 91



Win School Scheduler

period is affected. If the block appears more than once, every occurrence is
affected by the change.

Term: repeats changes made to 1 period, for the same periods on other days
in the term highlighted in Timetable Term. Term mode uses only periods
highlighted in the course’s Periods tab in Details. This mode never exceeds
the number of days over which the class should be spread, as defined in the
Periods tab in Details.

Year: is like Term mode, except that changes are made in all terms in which
the course is to be scheduled, according to the Sections window.

Timetable for

Specifies the type of timetable to display in the bottom part of the window:
for classes, room, or teachers.

Classes: you can edit the times, teacher, and room for the highlighted class.
Room: you can assign the Reserve Label to the highlighted room.

Teachers: you can assign the Reserve Label to the highlighted teacher in the
highlighted room.

Timetable Term

Term Numbers: click a term number to display the timetable for that term.
Term Indicators: below each term number is a pair of colored rectangles.

You can schedule a class only into terms with green rectangles under the
Term Number. If you want to schedule a class into another term, you must
change your selections in the Sections window. The left rectangle (Term
Indicator) is green if the term is selected in the Set Sections window for the
currently highlighted class. The left Term Indicator is white if the term is
deselected in the Set Sections window.

The right Term Indicator shows the scheduled status of the highlighted
class in that term. It is white when the class is not scheduled in that term,
red when it is partially scheduled, and green when it is fully scheduled in
that term.

To fully schedule a class for the year, the right Term Indicator must be
green in each term that the left rectangle is green.

Sched Year Button

The Sched Year button copies the schedule for the highlighted class for the
currently displayed term to all other terms selected for that class. In the
Timetable Term section, the left rectangle is green below these terms.

A Confirmation dialog appears when you click Sched Year. To skip this
dialog, press Control while you click. Click OK to carry out the operation.

This button is active only when Classes is selected in Timetable For, and
the class is scheduled in only 1 term.
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Class Teacher
A class can have up to 3 teachers each time it meets.

A teacher can be a different teacher type for different classes. If the selected
teacher type has not been assigned, N/A is displayed instead of a name in
the Timetable section of the window. The following list describes each
teacher type:

Main: a class is only fully scheduled with a Main teacher in each timeslot,
unless the course does not need a teacher and is set up that way in the
Scheduler tab in Course Details. Create Timetable assigns Main teachers
only.

Second: can only be manually entered in this window.

Aide: the Assign Aides command automatically assigns teacher aides to
courses.

Class Display Mode

Room/Teacher is usually selected. See “Manually Scheduling Classes” on
page 40 for more information on these options.

Lock Button

Use the Lock button to lock a class when you are satisfied with the
scheduling. This button is active only when Classes is selected in the
Timetable for section. To lock a class, highlight it, then click Lock.

Using School Timetable Lists

Class Name

When Classes is selected in the Timetable for section, the left scrolling list
displays classes, with VCR buttons for options.

Use the VCR buttons to select Teaches to show the number of active
students a teacher is responsible for in the selected year and term. If a
student is in 2 classes taught by the same teacher, that teacher is considered
responsible for 2 students.

If you used Class Combining from the Schedule menu to create groups of
classes, the combination class names also appear in the class pool.

Class names in color are not fully scheduled. Class names in black are fully
scheduled.

A padlock icon in the left margin means a class is locked, and Create
Timetable cannot change the schedule of that class.

Left-double-click a class name to highlight the scheduled teacher and room
in the teacher and room pools if the class has been at least partially
scheduled.
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Right-double-click a class name to display the class roster for that class in
the Student Subset view of the Main window. This replaces an existing
Student Subset with the class roster.

Control-left-click a class name to move the highlight to the next class in the
Class Pool that is not fully scheduled.

Reserve Label
When you select Teachers or Room in the Timetable for section, the left
scrolling list displays the reservation labels you created in School Setup.

Use reservation labels to prevent a room or teacher from being assigned to a
class at a particular time, before you use Create Timetable.

For more information, see ‘“Reserving Teachers and Rooms” on page 39.

Teacher Name

The first column displays teacher names. VCR buttons display teacher
numbers, employee numbers, and the teacher’s level of preference to teach
the current class in the Class Pool.

Control-left-click a teacher name to move the highlight to the next teacher
in the list with a preference to teach the class currently highlighted in the
class pool.

The course appears in the teacher’s Preferred Courses list on the Teacher
Details Scheduler tab. The names of these teachers are displayed in color in
the Teacher Pool.

Room Number
For each room, the room number and its capacity are displayed.
Control-left-click a room name to move the highlight to the next room in

the list that is potentially a good room in which to schedule the currently
highlighted class and teacher.

Rooms are displayed in color to indicate that both the highlighted teacher
and the highlighted class have preferences for the room.

Teacher Timetables

Teacher Timetables from the Windows menu lists teachers and timetable
blocks, displaying scheduled classes, class names, section numbers, room
numbers, and number of students.

If a teacher is not scheduled to teach a class in a particular block, “Free” or
the assigned reservation label is displayed.

Print individual teacher timetables by selecting them in Teachers view and
choosing Print from the System menu.
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Validate

View Options

From the System menu, choose View Options to display Teacher Timetable
information by block, by term, or by period for selected timetable days
only. The View Options setting also affects teacher timetables you print
from this window.

Validate from the Schedule menu verifies the consistency of Scheduler
data. A power outage or system failure can affect data. For example,
requests in the Main window for some students might not be the same as
the Student Requests report.

To validate Scheduler data:

1 From the Schedule menu, choose Validate to adjust inconsistencies in
the data.

2 From the Reports/Algorithm menu, choose Student Requests.

3 After the process is complete, verify that data is correctly displayed in
all relevant windows.

In the Teacher and Room Timetables windows, you can use View Options
from the System menu to display by block, by term, or by period for
selected timetable days. This command also affects timetables printed from
these windows.

Use View Options after creating the school timetable, when you want to
scan room/teacher schedules and reservation label assignments by block, by
term, or by period for selected timetable days only.

When you select View Options from the System menu, a secondary menu
appears to the side. A checkmark indicates the currently selected option.

e by Block displays all blocks from your timetable structure in columns
across the timetable window. All blocks are displayed for the first term
followed by subsequent terms. The column headings display block
letter and term number.

e by Term also displays all blocks, but rearranges the columns by term,
so all terms for each block appear before the next block in sequence.

e Monday, or Day 1, etc. depends on timetable structure: fixed days or
relative days. Selecting a day from View Options displays timetable
information by period for the selected day only, in columns across the
timetable window. All periods are displayed for the first term, then
subsequent terms. The column headings display day name (or number),
period number, and term number.
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Scheduler offers 4 categories of reports from the Reports menu. You can
choose Scheduler reports or custom templates that have been created in
Report Manager.

Special Courses
Fesource Check
Student Requests
Teacher Loading
Course Loading
Teacher Clusters

Course Request Tally

Wiait Lists

Class Rosters
Teacher Rosters
Free Students
Free Rooms
Transfers

Today's Add/Drop
Block Capacities
Student Clusters
Brief Requests

Timetahble Special
Course Check Requests
Class Student Locations
Foom Class Blocks
Student Feriod Schedule
Teacher Ethnic hix
Equivalent Full Time
Foom Freferences
Check Timetahles
Term-based Conflict katrix
Custom Templates...

™ Prirt matrix format
™ Pririt HH: bk

™ List requests

™ Print roam types

|B|DC|<. not printed in matris | = I

IF'eriDd nat printed in matris | = I

& Print blocks [and in rosters)
 Print periods

|5_ Mumber of days per page

— I Student Timetable
™ Homeroom
™ Locker number
™ Homeroom teacher
[ Counselorgdvisar
™ Home address
% Fhysical address
£ [ afling addiess

When you choose a report, Scheduler displays the Print Options dialog. Set
print options, and click OK to view the report in print preview. From the
print preview, you can print the report, or save it as a file.

Print Options E

—In TimeT able

— Mizc
I |Erief Tratiefen e part farmat
[ Page break between lists

Tinetatle dans

Frint terms

HRENE |

Report mezsage:

| Cancel |
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Using the System Menu

Block Capacities

Scheduler displays reports in print preview mode first. You can view all
pages of the report and decide if you want to print it or save it as a file.

Click the icon at the top left of the window to access the System menu. Use
the System menu to print or save the report.

bdail.
Frint...
SEve As .

Eestare
bdorwe
oize
kdinirmize
kMaximize

Close Alt+F4

Reports/Lists/Block Capacities

= Block Capacities Report

T
[E] Page |1 of 16 Completed 100% Slil
Block Capacities Repart
Chanceny Academy

Block Grade Students Clazzes Tatal Clazs Capacity Seatz Available Seats Filled

A1 10 2 a a 0% 0 0% 1} 0%
1 49 1 28 5% 16 57% 12 42%
12 51 2 a0 136% 51 51% 43 43%
Total 102 3 128 125% EY 52% E1 47%

B-1 1a 2 1] 1] 0% 0 0% 1} 0%
1 43 1 15 30% 0 0 24 160%
12 51 a a 0% 0 0% 1} 0%
Total 102 1 15 14% 0 0% 24 160%

CSL'%in School - Scheduler 4.0 Page 1 Tue, March 23,1993, 03:36 PM

For each grade and for the whole school, the Block Capacities report lists
the number of students, the number of classes, the capacity of those classes,
and the number of seats divided by the number of students.

This number should generally be above 100%, to allow all students to be
scheduled in a class in their grade level in that block. The report also lists
the number and percent of seats that are available and the number and
percent of seats that are filled for each block and grade.

When you have built your school timetable, check the class capacity to see
that enough seats are available for each grade level in each block.
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The capacity of a class is either the lesser of the Maximum Class Size
entered in Details and the Capacity entered in School Setup for the room in
which the class is scheduled, or the Capacity as edited in the Sections
window.

As you build student timetables, check the seats available and seats filled
statistics to identify problem blocks. Open School Timetable from the
Windows menu to see the classes scheduled in each block.

Reports/Special/Check Timetables

The Check Timetables report lists students who are scheduled into classes
for which they lack co-requisite or gender requirements. It lists those
classes and the missing requirement.

From the Lists menu, choose Timetable Problems to place all students with
specific requirement violations into the Student Subset, so you can easily
access and edit them.

Reports/Special/Class Blocks

The Class Blocks report lists the blocks the class is taught and the student
enrollment in each block for selected classes.

Print this report after your school and student timetables have been created.

Conflict Matrix or Term-Based Conflict Matrix

Windows/Conflict Matrix
OR
Reports/Special/Term-based Conflict Matrix

The Conflict Matrix from the Windows menu reflects the school year. The
Conflict Matrix report from the Reports/Special menu allows you to select
terms, in the event you are using Fragmented (term-based) course requests.

The Term-based Conflict Matrix report from the Reports menu is for
reporting conflicts in selected terms only. To make changes to the schedule,
use the Conflict Matrix window from the Windows menu.

Single-section classes are most affected by conflicts.
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Use the Conflict Matrix report to determine where a class should be
scheduled to minimize conflicts when filling student requests. You can look
for the least possible conflict in scheduling to the same block.

Generate this report before manually scheduling any class regardless of
whether you are manually scheduling your school or using Create
Timetable.

Conflict Matrix is particularly useful to pinpoint conflicts with limited
teacher, room, and class resources. Create Timetable calculates conflicts for
each course according to the number of sections, number of terms, number
of blocks needed and available, and room and teacher availability.

When working in the School Timetable window click Difficulties in the
Class Display Mode section to build the Conflict Matrix.

If you add or delete requests while the Conflict Matrix is open, a white
vertical bar appears in the title bar. Close and reopen the Conflict Matrix, to
update.

The Conflict Matrix lists courses on each axis. Each cell reports the number
of students with first-choice requests for both courses. The number of
requests for a course is in bold.

B Conflict Matrix Report - Terms 1.3.5 Scheduler-=g |=0] _ |O] %

Course Mame Advy. Spani_. Algebra 11 Algebra 12 Biology 11 Biology 12

| _'IA

Adv. Spanish
Algebra 11
Algebra 12
Biology 11
Bialogy 12
Biology Lab 11
Bookkeeping 11
Calzulus 12
Chermigtiy 11
Chemistiy 12

B =me kW o o
omonmonallEo
o oowo@oom
= === =
=== = =1

id

Double-click a cell to create a Student Subset with the names of all students
requesting both courses.

You can print this report in 2 formats:
e Matrix format, as it is displayed on the screen.

e List format, which prints to paper more quickly than the matrix, and
may be more useful to view. Deselect matrix format to print in list
format.

The list format displays the course number immediately to the left of the
course name. The number of requests is to the left of the course number.
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=% Resource Check Report !Em
Page i mi e emperea 10z S0 |
Resource Check Report
Chancen Academy
Course Fref Loadings Room [capacity]
Algebra 11 [2] 105 - Clagsroom [ 35]
10E - Classroom [ 35 ]
Arness, James 9 4.4.00.0 109 - Clazsroom [ 35)
Marin, Peter ] 0.0.0.0.0 Any Classroom
All blocks uzeable. Same period for 5 day(z], 2 term(s). Section Capacity [Min, Max]: 24, 28
Algebra 12 [2] Any Classroom
Amess, James 9 00,000 109 - Classroom [ 35 ]
ann, Peter 9 22000 Any Classroom
All blocks useable. Same period for 5 day(s). 2 term(s). Section Capacity [Min, Max): 25, 30
Biology 11 [1] Any Science Lab
Cavein, Tich | 1.1.00.0 Any Science Lab
Any Classroom
O'Reilly, Janet 0 22000 Any Classroom
Any Gyrnazium
CSL Win School - Scheduler 4.0 Page 1 Thurs, March 25, 1333, 1253 PM

Course Loading

To print the conflict matrix:

1

From the Windows menu, choose Conflict Matrix.

Double-click any cell in the conflict matrix to see a list of the students
requesting those 2 courses as a Student Subset.

In the Conflict Matrix window, choose Print from the System menu.

Deselect “Print matrix format” to display the “Single-Section Courses”
option. Single Section Courses prints in list format.

While single-section classes require less memory, they are most
affected by conflicts. For example, students who request 2 single-
section classes will get only 1 of the classes if the 2 are scheduled for
the same time.

Click OK.

Reports/Algorithm/Course Loading

The Course Loading report describes teacher loading for selected courses.
Beside each teacher name are preference for the course, number of sections
and blocks loaded, and number of sections and blocks scheduled.

Use this report after loading teachers and after building a timetable to
compare teacher scheduling versus loading.

You cannot print this report while Create Timetable from the Schedule
menu is running.
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Course Request Tally

Reports/Algorithm/Course Request Tally

The Course Request Tally shows the total number of requests, sub-totaled
by gender and grade level, for selected courses. The number of sections is
in brackets.

Use this report to check request distribution among courses and grade
levels, and to discover gender discrepancies.

If your school has more than 9 grade levels, print this report in landscape
orientation to fit all the information across 1 page. If your school has more
than 15 grade levels, change the level of reduction for this report.

Equivalent Full Time

Ethnic Mix

Reports/Special/Equivalent Full Time

Equivalent Full Time (EFT) means the percentage of a full-time teacher’s
schedule that a course requires. Set up the EFT for each course in Details.
Some schools also use the term Full-Time Equivalent or FTE.

This report lists all courses by department. For each course, it lists the
number of sections, the EFT per section and the EFT required to teach all
sections. For each department, it lists the total EFT required, and at the end
of the report, the total number of classes and the total EFT required.

Use this report to evaluate the number of classes created in terms of teacher
resources.

Print options, Page break between lists, and Print Terms affect this report.

Reports/Special/Ethnic Mix

The Ethnic Mix report produces gender and ethnic category statistics for
selected students.

Select all the students in a class roster, program, or grade to generate
statistics for those groups.
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Reports menu/Lists/Free Rooms

For selected rooms, the Free Rooms report lists for each block during
selected print terms, all rooms that are free. Blocks in which no rooms are
free are not shown.

Use this report to help you find empty rooms when building the master
timetable.

Reports/Lists/Free Students

For selected students, the Free Students report lists, in each block during
the selected print terms, all students who are free. Blocks in which no
students are free are not printed.

Use this report to help you finish filling student timetables.

Reports/Special/Period Schedule

For selected classes, the Period Schedule report lists all the periods in your
schedule and shows the selected classes in the periods in which they are
taught. This is a list version of the Class Timetable report matrix.

After creating the school timetable, use this report to view some or all of
your classes in a school timetable.

Reports/Algorithm/Resource Check

For selected courses, the Resource Check report lists the teachers loaded.

For each course, it lists the number of classes, room preferences, available
blocks, number of days and terms, and maximum and minimum class sizes.

For each teacher, it lists the teacher’s level of preference for the course, the
number of sections loaded for each term, and room preferences.
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% Resource Check Report !Em
[EE] Page |1 at s ‘ Complated 100% Stil
Resource Check Report
Chancery Acadermy
Course Pref Loadings R oom [capacity]
Algebra 11 [2] 105 - Clazsroom [ 35 ]
106 - Classroom [ 35 ]
Arness, James 9 44,000 109 - Classroom [ 35 )
Mann, Peter ] 00,000 Ay Clazzioom

Algebra 12 [2]
Armess, James
Mann, Peter

All blocks ugeable. Same period for

All blocks uzeable. Same period for 5 day(s). 2 term(s). Section Capacity (Min, Max): 24, 28

B day(z]. 2 term(s). Section Capacity (Min, Max). 29,30

Ay Classioom
9 00,000 109 - Clazzroom [ 35 )
3 22000 Ay Clazsroom

Biology 11 [1] Any Science Lab
Cavein, Tich 9 1.1.000 Any Science Lab
Any Clazsmam
O'Reilly, Janet ] 22,000 Any Classoom
Any Gymnagium
CEL 'Win School - Scheduler 4.0 Page 1 Fri, March 26,

Room Preferences

This report is invaluable in analyzing why Create Timetable cannot
schedule a class. See “Step 4: Creating the School Timetable” on page 37.

This report is also useful when setting sections, as it reports courses’
maximum and minimum class sizes as defined in Course Details.

You cannot print this report while Create Timetable is running.

Reports/Special/Room Preferences

The Room Preference report lists either selected teachers and the rooms for
which they have preferences, or selected rooms and the teachers with
preferences to teach in them. It also prints an estimate, based on the number
of courses with preferences for the room, of the number of sections that will
be scheduled into the room, indicating how busy each room will be.

If both rooms and teachers are selected, the teacher selections are ignored,
and the report is printed only for the selected rooms.

Print this report before or during the creation of your school timetable.
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Special Courses
Reports/Algorithm/Special Courses

The Special Courses report lists courses with special requirements, and all
courses scheduled in the Special Courses phase of Create Timetable:

e Linked Groups courses

e Following Triplets courses with their group numbers.

e Courses with all sections in same period selected in Course Details.
e Courses with student Clusters selected in Course Details.

e Courses chained together by the Preceding Course setting in Course
Details, Scheduler tab.

e Block-restricted courses. Courses that cannot be taught in all blocks.
e Courses with extra periods.

e Combined classes, which are classes scheduled for the same time,
teacher and room. An asterisk (¥) indicates the representative class.

If you are having difficulty in the Special Courses phase of Create
Timetable, print this report to get a listing of the groups it is scheduling.

Student Clusters
Reports/Lists/Student Clusters

For each program-grade, this report lists the students in each cluster and
their classes. Off Team appears in the row for any class not in that cluster.

Use this report to identify clusters and the students assigned to them.

Student Locations
Reports/Special/Student Locations

For selected students, the Student Locations report prints their scheduled
room number for each block of the school timetable.

Print this report when student timetables are complete to see where a
student is in any period.
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Student Requests

Teacher Clusters

Teacher Loading

Reports/Algorithm/Student Requests

For selected students, the Student Requests report lists requests, whether
they are required R, or elective E, courses, and whether the student meets
all prerequisite, co-requisite, and gender requirements.

For each course, if the student meets a prerequisite or co-requisite
requirement, that column is blank. Otherwise the relevant course name is
displayed. N is displayed in the Gender column if the student does not meet
the gender requirement for a course.

Use this report to check that requests are entered correctly, or to find
requests where prerequisite, co-requisite, or gender requirements are
incorrect.

Reports/Algorithm/Teacher Clusters

The Teacher Clusters report lists the clusters for each program, the courses
taught in those clusters, and the teachers assigned to those courses, with the
number of sections in brackets. The numbers beside the teacher names are
the section numbers of each course to which each teacher is assigned in the
Clusters & Teams dialog.

Print this report if you have assigned teachers to classes in the Clusters &
Teams dialog from the Schedule menu.

This report describes the contents of the Clusters & Teams dialog, not what
is scheduled. If you manually schedule classes without referring to the
Clusters & Teams dialog, then this report will not reflect the schedule.

Reports/Algorithm/Teacher Loading

For each selected teacher, this report lists the maximum block load and all
the courses that the teacher has a preference for, is loaded for, or is
scheduled into.

For each course, this report lists the number of blocks required to teach a
section, the teacher’s preference, the number of terms the teacher is loaded
for, the number of blocks the teacher is loaded for, the number of sections
the teacher is scheduled into, and the number of blocks the teacher is
scheduled into.

Use this report when loading your teachers to check which courses a
teacher is loaded for and when creating your school timetable.
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You cannot print this report while Create Timetable is running.

Reports/Lists/Teacher Rosters

For each selected teacher, the Teacher Rosters report shows teacher, room,
number of students, and a class roster for each class the teacher teaches.
The class roster shows all students in the roster for selected terms. Any
student enrolled in the class only during terms not selected will not appear.

Use this report to give teachers their class rosters and the schedules of the
classes they teach. This report is the same as the Class Rosters report,
except it prints according to teacher.

Reports/Timetable/Course

After creating the school timetable, use the Course Timetable report to view
some or all of your classes in a school timetable.

Print by Period displays periods down the page, and days across the page.

Print by Course displays courses, by the day, down the page, and periods,
by the day, across the page.

Reports/Timetable/Room

For selected rooms, the Room Timetable report lists all the classes,
teachers, and total number of students enrolled in each term by room. The
report can be printed in list format, by block, or in matrix format by period
and day.

Print this report during or after creating your school timetable.

Reports Menu/Timetable/Student

For selected students, the Student Timetable report prints the classes,
teachers, and rooms that they are scheduled into in either list or matrix
format.
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Teacher Timetable

Today’s Add/Drop

Transfers

If classes are in list format and Print Periods is not selected in the Print
Options dialog, classes appear by block. Otherwise they appear by day and
period. Use Print Options to include homeroom, locker number, homeroom
teacher, counselor, and address in the report.

Use this report after completing student timetables to give each student a
timetable.

Reports/Timetable/Teacher

For selected teachers, the Teacher Timetable report lists scheduled classes,
rooms, and total number of students enrolled in each term by teacher. The
report can be printed in list format by block or period, and in matrix format
by period and day.

Print this report during or after creating your school timetable.

Reports/Lists/Today’s Add/Drop

For each teacher whose rosters have changed, the Today’s Add/Drop report
prints:

e The names of classes with changed rosters.

e The name, grade, and student number of students who transferred in or
out of a class on a selected transfer day.

You can print this report daily and distribute it to teachers to advise them of
changes to their class rosters.

Reports/Lists/Transfers

The Student Transfers report lists Historical timetables for selected students
and classes.

Scheduler records students scheduled in every block of the year, and
assumes that information is true from the beginning of the school year to
the end. If a schedule changes, the effective dates of the old schedule
become from the beginning of the year to the currently selected transfer
date, and the new, changed schedule is dated from the following day to the
end of the year.

Every day a student timetable changes, the effective date on the last
timetable is changed and a new timetable is added. If you run Scheduler to

Printing Reports e Today’s Add/Drop 107



Wait Lists

Win School Scheduler

reschedule 1 student, that student ends up with several Historical
timetables.

Classes have Historical rosters which record the students in a class during a
date range, and every time a student transfers in or out of a class, a new
Historical roster is created.

Student Historical timetables display the date range for the timetable, then
list each block and term and its scheduled class. Free blocks are not listed.

Class Historical rosters show the date range for the roster and list the names
of students in the class. The final column indicates the terms in which the
student is enrolled in the class. “P” indicates that the student is enrolled in
that term. “A” indicates that the student is not enrolled in that term.

The long format lists Historical timetables for selected students and/or
Historical rosters for selected classes.

Select “Brief Transfer Report format” to show the dates each selected
student added or dropped classes.

Run this report to verify a student timetable or class roster for a particular
date.

Reports/Lists/Wait Lists

For each selected course, the Wait Lists report lists all the students
remaining on the wait list, the total number of requests for the course, and
the percent of requests filled.

As you enter course requests, you can see which students are requesting a
course. As you create student timetables, you can see which students have
not yet been scheduled into requested courses.
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Troubleshooting

Solving Problems in Scheduler

Make sure no one is using Win School before you make changes in
Scheduler Master mode.

If your schedule does not appear to be complete

You need to optimize your timetable.

To optimize your timetable:

1
2
3

From the Schedule menu, choose Create Timetable.
Set options and click Optimize.

Adjust your schedule and settings and repeat this process until Win
School reports that everything is in its optimal position.

If a student is not scheduled for required courses

It is likely the student’s electives are listed before his or her required classes
in requests. To correct the problem, you will have to re-assign the student’s
required courses ahead of his or her electives.

To re-assign the compulsory courses:

1
2
3

Select the required courses.
From the Schedule menu, choose Assign Students.

Select the “Use selected courses only” option, as well as any other
options used by your school. Click OK.

Select the other courses. In this case, select the electives.

From the Schedule menu, choose Assign Students again, and repeat
step 3.

If students are not fully scheduled

Check if the student has the label Can Take in the Student Requests
window. If so, you need to reassign the student. This problem occurs when
Assign Students is not given enough time to schedule the last few requests
in the student request lists.

Scheduler does not automatically remove a student after the student has
been placed.
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To fully schedule students:

1
2
3

From the Schedule menu, choose Assign Students.
Select the Use Backtracking option.

Increase the amount of time you allow per student in the Maximum
time per student field.

The greater the time you set, the longer it takes Scheduler to schedule
the students.

Click OK.

If there are inconsistencies in teacher/room/students timetables

You should validate your timetable. From the Schedule menu, choose
Validate. This command analyzes the Scheduler information and correct
any problems it encounters.

Check Details = impossible/conflicting combination of clocks/days/periods/extra

periods

Points of Interest

This message appears if Scheduler cannot schedule a class because there is
inconsistent course information in Details.

1
2
3

Start Details.
In the Courses view, double-click the course that wasn’t scheduled.
Check in the Scheduler tab:

e If the course is part of a combined class, Linked Group, or
Following Triplet, all the other courses in that group must have the
same Scheduling Term Information settings, and the Use in
Scheduler field is set to Yes.

e [f the course is part of a combined class, the Teacher Required,
Room Required, and Student Clusters fields must be identical for
all courses in the combined class.

In the Periods tab, check that the number of periods per day is no
greater than the number of periods in a day set in the Timetable
Structure dialog in the Scheduler menu in School Setup.

Question

Answer

How many Terms can be scheduled? 12. The fewer you need the less disk space and memory used.

How many Periods can be scheduled? 42.
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Question

Answer

How many Blocks can be scheduled

Blocks x Terms = maximum 1200.
Maximum blocks per term: 304.

The fewer you need, the less disk space and memory used.

Why can’t I create a Timetable?

You might have reached the Time Record maximum of 32,767.
When you click the Scheduler Information icon in the title bar of
the Scheduler Main window, the “Meeting times of all classes” is
your Time Record, and it cannot be more than 32,767.

Blocks x Terms = maximum 1200.

Maximum blocks per term: 304.

Can you change the number of terms
after School Timetable is created?

Yes, but you will have to reschedule your classes and students in
Scheduler.

Why don’t student timetables print all
of the periods?

Periods defined in School Setup as O minutes in length will not
print on student timetable reports in either List or Matrix modes.
For example: 00:00 - 00:00 or 12:45 - 12:45.

Can I exclude periods from printing on
the teacher timetable report?

Periods defined in School Setup as O minutes in length will not
print on teacher timetable reports when run in Matrix mode. For
example: 00:00 - 00:00 or 12:45 - 12:45.

In the Sections window, does the
teacher need to be loaded for all
members of a combination class?

No, load a teacher for the representative class.

Why are the green triangles disregarded
when manually scheduling a class on
the School Timetable?

The green triangles are visual aids only when manually
scheduling a class. It is only when Scheduler is building the
School Timetable that it looks at the period/block constraints
defined in Details. If you need to schedule a class using different
time periods, select Block or Period in the Enter by section.

Can I limit the number of students a
teacher can teach?

No, but you can see the number of students a teacher is scheduled
to teach in the Teacher Main window. Select Teaches from the
VCR buttons. This information is also available in the School and
Student Timetable windows.

How do I limit the size of my
combination class to 30 students?

Enter the maximum number of students for individual sections of
a class in the Sections Main window. If a combination class has 2
member classes, set each class so the maximum class size is not
exceeded.
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Question

Answer

When I copy and paste 1 student’s
timetable to another, the results don’t
always match. Why?

Scheduler will try to fully schedule the target student into each of
the original student’s classes. If the student you are copying has
an incompletely scheduled class, the 2 schedules will not match.
Scheduler does not schedule by block, but tries to fully schedule
the class. For example, if the original student is scheduled into 2
classes out of a possible 5 classes a week, when you paste the
timetable, Scheduler will try to schedule the student into all 5
classes.

Preferences also affect pasting, depending on which option you
choose in the When Pasting Classes section in Scheduler
Preferences.

When I select Enter by Block in the
School Timetable window, why can’t I
see the same block letters I used in
Timetable Structure under School
Setup?

School and Student Timetable windows use Block Labels that are
defined in Block Labels in the Scheduler menu in School Setup. If
you need this information to appear in Scheduler, include a Short
Label at the start of the Block Label. For example: A Period 1.

I use multi-paste to give my students
core course requests. When I manually
add electives, why are the elective
requests at the top of the request list?

The highlighted item in the Requests column of the Student
Request window determines where the manually added requests
will be placed.

On the Check Requests report, why
does the Course Name appear as ‘...
instead of the actual course name?

There is no grade level set in Details for that course. Courses with
a grade level set to N/A in Details will print “...".

Why aren’t my courses showing in the
Clusters & Teams dialog?

For courses to display in the Clusters & Teams dialog, 3 elements
have to be set in Course Details:

e  General tab: course has a grade level.

e Scheduler tab: set Student Clusters to Yes.

e Lists/Required tab: course set for a Normal Program.

Some of my Scheduler reports truncate
long course numbers. What can I do to
see the whole course number?

In Preferences from the Edit menu, change Course Name Format
to Number Name Grade.
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Glossary

Block

Class

Class Roster

Course

Cycle

Scheduler schedules according to blocks, not periods.

Block is the smallest unit of time, representing classes, teachers, rooms, and
students taught at the same time. Blocks are identified by letters.

Blocks can be repeated throughout your timetable which means the same
students and teachers will be in the same rooms for the same classes at different
times. If even 1 element changes, it is considered a unique block, which is
important in calculating how many blocks your school needs.

If you move a block letter from one time to another, you change the time that all
the classes scheduled in that block are taught.

If you duplicate a block letter, adding it to a new period in the timetable, all the
classes scheduled in that block are now also taught in the new time.

In general, a class is the smallest unit a course can be divided into. A course can
consist of only 1 class, or many classes. For example, 90 Grade 11 students are
requesting Biology Lab 11, and each lab room can hold up to a maximum of 30
students. So 3 classes were created to accommodate the demand: Biology Lab
(1), Biology Lab (2), and Biology Lab (3).

Class is also used in the term Class Rank, which indicates the standing within a
grade level that students are assigned based on their marks.

A roster consists of the students and teacher assigned to a class, or section, of a
course.

A course is an instructional subject taught in a school, divided into classes
(sections). For example, 200 Grade 11 students requested English 11 and
Spanish 11 this year.

The single completion of a schedule, such as a day or a week. Cycles repeat and
are affected by holidays.

Cycle is the largest unit of time, measured in days.
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Day
Day is a series of blocks, 1 block per period. A block taught in 1 day may be
unique to that day, or it may also be taught on other days.

Following Triplet
Courses taught in consecutive periods, where the teacher and room may change.
For example, Biology and Biology Lab, or Math 11a, 11b, 11c where algebra,
geometry, and trigonometry may be taught by different teachers.

Fragmented Course Request
Where students request part of a course in one year and other parts of the course
in another year. For example, taking term 1 of Algebra 10 this year and term 2
next year. Also called Term-based course request.

Grade
In general, a grade is the instructional level that a student is currently in, or that
a course is given in. For example, 200 Grade 11 students enrolled in Grade 11
English this year.

A grade is also used to indicate a mark that a student has received for a class.
For example, in a Grade Distribution report.

Linked Group
Courses taught in the same period on the same day, or in the same period on
different days, or in the same period in different terms. The teacher and room
may change.

Period
Standard amount of time in which blocks and classes are scheduled.
Roster
A roster includes the students and teacher assigned to a class, or section of a
course.
Section

In general, a section is the same as a class.

Section is also used in the term Section Rank, which indicates the standing
within a class that students are assigned based on their marks.

Term-based Course Request
See “Fragmented Course Request.”
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Terms Offered

Terms Requested

Terms Taught

Time record

Timetable

The terms in which a class can be taught. This is set in the Set Sections dialog.

A student’s requested terms.

The way a class is scheduled.

Unit of time within a schedule to a maximum of 32,767 Time Records.

To see your Time Record, click the Scheduler Information icon in the title bar
of the Scheduler Main window. The “Meeting times of all classes” is your Time
Record.

The term used by Win School for a student, teacher, and school schedule. Also
referred to as a schedule.

Glossary e Points of Interest 115



Win School Scheduler

116 Glossary e Points of Interest



Win School Scheduler

Index
Counselor, 4, 6, 14, 107
A Course
Allow partially scheduled classes, 61 Definition, 5
Assign Students, 55, 78, 81, 85, 109 Courses, 4, 28, 32, 33, 34, 82
troubleshooting’ 61 FOHOWing Triplets, 37, 79, 104
Attendance, maintaining accuracy, 67 Linked Groups, 37, 79, 104
special, 15, 47, 48, 52, 84, 104
B with clusters, 35, 79, 104, 105, 112
Backtracking, 60, 79, 80, 110 Create Timetable, 27, 31, 32, 39, 42, 49, 51, 52,
83,93, 99, 102, 104, 109
Block, 1, 12, 13, 14, 24, 29, 30, 31, 33, 34, 36,
37,38, 40, 41, 42, 43, 44, 45, 46, 48, 49, 50, Pre-Check, 38, 45, 46, 84
52,54,57,58, 61,62, 64, 67,68, 84, 86, 87,
90, 91, 94, 95, 99, 104, 105, 111 D
data
C

preparing for next year, 10

Changed, 7, 45, 49, 50, 51, 52, 66, 82, 86, 90, Data folder archives. 4
107 ’
Data Transfer, 23, 85, 88
Class
o DDI, 23
Definition, 5 o .
Difficulties

Class attendance, maintaining accuracy, 67 . .
based on Conflict Matrix, 99

District Data Integrator, 23

District Items, 13, 23
displaying, 25, 65, 89
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F2, 19, 20, 27

F3, 6, 18, 58, 72
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Fax for Technical Support, 2
Feedback for documentation, 2

Following Triplets, 13, 15, 37, 48, 52, 79, 104,
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Hide, 89
Historical data, 10, 79, 107

Historical Student Timetables and Rosters, 66,
67, 108

Homeroom, 4, 14, 107
Roster, 6
Homeroom Numbers

assigning automatically, 76

I

Icon

padlock, 43, 93

Scheduler information, 4, 19, 20, 59, 61, 111
Import Scheduler data, 86
Inactive Students

Inactive Students shown or hidden, 6, 89
Inconsistencies, 95, 110
Information icon, 4, 19, 20, 59, 61, 111
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K

Keep Teachers in Homerooms, 45
Keys, 4, 6, 18, 19, 20, 27, 58, 72

L

Launch modes, 3
Linked Groups, 13, 15, 37, 48, 52, 79, 104, 110
Lock icon, 43, 93

M
Main window, 4, 53

Lists view, 7
Student subsets, 6, 7
students missing, 6, 88
Students view, 5, 70, 72
Missing students
from Main window, 6, 88
Multi-Pasting, 20, 34, 56, 58, 67, 68, 90, 112

N
New Schedule

using New Schedule before setting sections,
25

Next Year Prep, 10

(0

Other schools, 23, 65, 89
Overfilling, Load Teachers, 30, 31

P

Padlock icon, 43, 93

Partially locked, 48

Partially scheduled, 61, 73, 78, 92, 93
Paste Requests, 17, 19, 20, 58, 67, 112
Performance window, 53, 62

Phone number, Technical Support, 2
Power outage

validating data after, 95
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Prerequisites, 7, 13, 17, 22, 23, 63, 64, 79, 105

R
Reports

for teacher loading, 33
Req, 5, 21, 63, 72
Request List, 6, 19, 58, 59, 82, 109, 112
Request Problems, 7, 22
Requested<Required, 7, 21
Rescheduling

Class, 42, 43,67, 111

Room, 68

School Timetable, 67

Student, 67, 80, 108

Teacher, 68
Rescramble Periods, 37

Reservation labels, 12, 24, 39, 40, 41, 55, 82,
83, 90, 92, 94, 95

Reserving courses, 34

Reserving Periods, 49, 50, 55

Reserving teachers, 31

Reserving teachers and rooms, 38, 39, 90

Room Timetables, 4, 39, 48, 54, 90, 106
view options, 95

Roster, 3, 5, 6, 34, 64, 106, 107

Rqd, 6, 21, 63,72

S

Sch, 5, 21, 63,72
Schedule Only Selected Courses, 45, 49
Scheduled<Requested, 7, 60, 63
Scheduled<Required, 7, 63
Schedules from other schools, 24, 25, 65
Scramble Periods, 36, 37, 90
Sections, 29

editing section numbers, 26, 27, 28, 36, 86

Sections window, 4, 26, 27, 29, 46, 49, 61, 72,
91,92,98, 111

Select sections

according to Following Triplets, 78
according to Linked Groups, 78
Selected

courses, 18, 19, 23, 28, 34, 45, 49, 61, 80,
100, 101, 109

students, 6, 18, 19, 21, 22, 23, 59, 64, 76, 77,
81, 82

Setting up
Details
Course Data, 13
Student Data, 14
Teacher Data, 14
School Setup, 12
Show, 89
Show All District Items, 24, 25, 65, 89
Show Grade N/A Students, 89
Start Date for Change, 68
Startup modes, 3
Student Historical timetables, 108

Student subsets, 4, 6, 7, 19, 20, 21, 22, 23, 59,
64, 67,70, 77, 94, 98, 99, 100

Student Timetable Building
dates for transfers, 67
Historical Timetables and Rosters, 66, 67
Students missing
from Main window, 6, 88
Study Hall, 39, 55, 61
Superimpose, 42, 58

System menu, 21, 22, 23, 28, 38, 53, 65, 90, 94,
95,97, 100

T
Teacher Timetables window, 4, 54, 66, 94

view options, 95
Teaches column, 57, 93
Teaching Teams, 15, 34, 35, 105, 112
Technical Support, contacting, 2

Term-based course reqeusts. See Fragmented
Course Requests

Timetable Problems, 7
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Transferring data, 23, 84, 85, 88

Transferring students, 67

Troubleshooting, 109
Assign Students, 61
Block or term restrictions, 46
Create Timetable, 48
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V
Validating Scheduler data, 95, 110

W

Wait List, 6, 23, 41, 43, 74, 108
Website for Chancery, 2
Win School data

preparing next year, 10
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